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1 Introduction 
These training notes provide a reference during and following Civica’s Administration Manager 
training. They cover all of the main sections of the software. The Administration Manager Manual 
provides a comprehensive guide to the software 
 
During training we will be working with fictitious data and all the exercises contained within this 
user guide refer to that data  
 
The training is designed to start with the focus of the integrated set of modules – Student Details, 
to provide users with an understanding of the look and feel of the software. The program 
progresses through the other functions and features of the software 
 

1.1 What is the Administration Manager Module? 

Administration Manager is a Windows-based database that enables schools to keep detailed 
student and staff records and use these records to produce a wide range of reports. Student data 
is stored in four data sections – Admissions, Current Roll, External Roll and Former Roll. Each 
student record is divided into several sections such as personal, additional information, activities, 
attendance history, medical details and teaching sets. There is also an Emergency feature for fast 
access to student data. 
 
Other functions include Speed Edit, Control functions, Year End functions, Admissions, Standard 
and Ad Hoc Reports 
 
The system is relatively easy to use and maintain. Administration Manager is a powerful tool that 
will give administrators smooth access to information with a well-structured, logical layout 
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1.2 Administration Manager Training Program 

Day One 

Time Content 

9.00 am Introduction 

Menu Bar 

Side Bars 

System Preferences 

Parameters  

10.30 am Morning Tea 

10.50 am Staff Details 

Administrator Tasks 

Student Details 

Current Roll 

12.20 pm Lunch 

1.00 pm Admissions Roll 

Former Roll 

Importing and Exporting Student Data 

2.30 pm Afternoon Tea 

2.50 pm User Defined Information 

Speed Edit 

Ad Hoc Report 

Groups 

 

Day Two 

Time Content 

9.00 Review Questions 

9.15 am Mail Merge 

10.30 am Morning Tea 

10.50 am School Details 

Year End Process 

12.20 pm Lunch 

1.00 pm Year End Process  (cont.) 

Reports 

3.30pm Finish 
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1.3 Training Outcomes 

 
At the end of the two days, training participants will be able to: 
 

 Navigate their way through the side bar options in both the General and Administration 
Modules of Integris. 

 Set up system defaults and preferences 

 Locate and edit specific parameters 

 Enter staff details 

 Set up users 

 Set up User Permissions  

 View, find, add and edit student records 

 Use the current and external rolls to enrol students 

 Produce an emergency report 

 Move students to the Former Roll 

 Use the Admissions Roll to enter students 

 Understand the procedures for importing and exporting data 

 Create a User Defined Field 

 Speed Edit student records 

 Produce an ‘Ad-Hoc’ report 

 Create Groups 

 Create a kst template for use in Mail Merge 

 Use the mail merge function to generate a document 

 Use MS Word to produce a Mail Merge document 

 Follow the Year End Process 

 Produce standard reports 
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1.4 Logging On  

Activity: 
 

 To log on, double click on the Integris Training icon on the desktop 
 

 
 

 Type ADMIN as the User Name for use in today’s training 

 Press <Tab> to move the cursor to the Password box  

 Enter the password: keys 
 

  
 

 Click on Login or press <Enter>  
 

Note: It is strongly recommended that you change your password once a month. 
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2 Menus  

 

2.1 The File Menu  

 
 

2.1.1 Change Password 

Once users have been set up with access to the software, they can change their password at any 
time. 
 

Activity 

File > Password  

 
 
The user would enter their Current Password, press <Tab> to the New Password field and 
enter the new password, then enter the new password again in the Verification field. 
 

 Click Cancel as we will not be changing passwords today 
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2.1.2 Change User 

If the software is open and another user wishes to use it, make sure they log on using their own 
user name and password to ensure they only have access to the appropriate sections of the 
software. 
 

Activity 

File > Change User  

 Log in again with the User Name ADMIN and the Password keys 
 

 

2.1.3 Lock Terminal 

Some sections of the software display confidential data.  If a user is working on confidential data 
and needs to conceal the data, or if they are leaving the computer and do not want anyone else to 
use the software while they are away, they can use Lock Terminal to temporarily lock the screen 
 

Activity 

File > Lock Terminal 

 
 
The screen is locked 

To unlock the screen: 

 Click Unlock 

 Enter your password  
 

 
 

 Click OK 
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2.1.4 Single User Lock 

Use Single User Lock to bar global access to Integris when single user mode is required.  This 
function is accessible to all users with administrator status  
 

Activity 

File > Single User Lock 

 
 

 Enter your password  
 

 
 

If other users are logged in, their details can be displayed via the View Users button  
so that the administrator can ask them to exit the system. 
 

 Click OK  

The following icon appears under the Menu Bar:  
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When the lock is applied, users attempting to access the system will be presented with a 
message indicating the system will be unavailable for a specified period of time. This window will 
automatically close and exit the Integris session after 15 seconds.  Only Administrators who 
initiated the lock can log into Integris at this time. 
 

 
 

To return to Multi-user mode: 

 Click Single User Lock  

 Click Restore Multi-user 
 

 
 

 Type your password  

 Click OK  or Press <Enter>  
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2.1.5 Report Destination 

Activity 

File > Report Destination 

 
 

 View the various options 

 Click Cancel 
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2.2 The Help Menu 

2.2.1 Help Contents and Index 

Activity 

Help > Help Contents and Index 

 
 

 Highlight Integris Administration Manager Help 

 Click Help 

 View the Administration Manager manual 

 Click Close 
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Notes: <Ctrl + F> allows you to search a document for a specific topic. Check Section 22 of 
these Training Notes for all details of Support available to schools.  Holding down <Shift> 
<Ctrl> + F will open the Full Reader Search window as shown below. 
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2.3 Using the Side Bars 

Once you have logged onto the system, a blank window with a control panel (side bar) appears on 
the right-hand side of the screen.  The General side bar is displayed. 
 

 
 

Activity 
 

 Click on each of the sidebar headings and view the various icons in each 

 In today’s training the following modules are loaded: 
 

 
 

 
  

 

The Administration Module comprises two 
sidebars.  The one on the left of this page is 
the General side bar.  This provides access 
to the core functions.  From here, you can 
enter school details, view and enter student 
and staff details and create groups of 
students and staff.  
 
It is also where schools set up their own 
parameters for the system and use the 
Control function to add new modules and 
set up new users and passwords. 
 
By clicking on the Admin tab on the bottom 
of the side bar, a second bar is revealed.  
This is the Admin side bar - seen on the 
right. 
 
The Admin side bar provides an emergency 
report function, enables users to speed edit 
information in students’ records, carry out 
Year End procedures and produce reports. 
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3 System Preferences 

General > Control > Preferences 

Activity 

General > Control > Preferences > General tab 

Integris is able to accommodate visiting students who may come to a school for various periods 
or activities on a regular basis, but who are not actually enrolled at the school. 
 

 Tick External roll active for students 
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General > Control > Preferences > Paths tab 

The paths tab displays the default pathways that Integris uses to locate images, import and 
export data and to saved mail merged kst documents. 
 

 
 
Enter the pathway by clicking on the magnifying glass icon and locating the folder. Click on the 
folder, the path will now be displayed in the Directory Image Path field as shown above.  
 

General > Control > Preferences > Defaults tab 

 
 

Note: The option of ‘No Default Gender’ must be selected for WA DoE schools. When 
adding new students the gender will then appear blank and the user must select the 
relevant gender. 
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General > Control > Preferences > Reports tab 

 
 

 Tick the box to Display Report Location Footers 
 

General > Control > Preferences > eMail/Web/Login tab 

 
 

 Change the message if required 

 Click  and navigate to C:\keys\INTEGRIS\PHOTOS to select a new image  

 Click OK to save changes 

Note: The maximum size for a jpeg file is 23.5cm x 12cm. Optimal size is 600 x 350 pixels. 
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4 Parameters 

General > Parameters  

Various windows within Integris contain fields with information.  Some of these fields have drop-
down menus.  The items in these drop-down menus are referred to as Parameters.  In other 
words, many fields are completed by choosing values from a list.  For example, when adding a 
staff member’s Indigenous Status, a user cannot simply type in Aboriginal, it must be selected 
from a pre-defined list.  These lists are set up in Parameters.  

Note: The length of Parameter codes is set up in Control > Preferences > General > 
Parameter ‘code’ digits. 

The Department of Education (DoE) manages several data fields.  These fields must not be edited 
or added to.  DoE will ensure that these key parameter fields are updated as required. The 
managed fields are: 

 

 Allowance Type 

 Country of Birth 

 First Language 

 Indigenous Status 

 Previous/Destination School 

 Religion  

 Year Groups 

 VISA Sub Class Numbers 

 

Activity 

General > Parameters > Country of Birth 

 Highlight Australia  

 Click Make Current Line Default  
 

 
 

 Close the window 
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General > Parameters > Relationship Type 
 

 
 
The Parameters window displays all the parameters.  Some can be added and also edited. 

Note:  Not Specified parameters should not be edited or deleted 

 Right click in the list of Relationship Type 
 

 
 Select Add/Edit Parameters 

 Enter 21 as the Code 

 Enter Partner as the Description 
 

 
 

 Click OK 
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 Highlight the new parameter and lock it  

 

 Click Yes to the message 

 Close the Relationship Type Parameter 
 

General > Parameters > Medical Practices 

 

 
 

 Click Add Practice   

 Enter the details of a Medical Practice close to your school 

 Click OK 

 Close the Medical Practices parameter 
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General > Parameters > Student Activity Types 

 Add the activity type Parent Contact 

 Right click in the list of Student Activity Types  

 Select Add New Parameter 

 Enter PC as the Code 

 Enter Parent Contact as the Description 
 

 
 

 Click OK  
 

 
 

 Close the Student Activity Types window 
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5 Staff Details 

General > Staff Details 

Administration Manager can hold details on staff.  The staffing section of the system is accessed 
via the Staff Details icon on the General side bar.  Functionally it is very similar to the Student 
window, using many of the same icons. 
 

 
 

To add a new member of staff click Add.  The following window will appear, enabling users to 
enter relevant information.  
  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 29 of 218 

© 2019 Civica Pty Ltd 

 

 

 
 

To edit a staff member’s details, locate their record and click on Edit.   
 

Activity 

General > Staff Details 

 Click Add   

 Enter the following information about yourself, tabbing between the fields: 
o Title 
o Surname * 
o First Name * 
o Gender 
o Date of Birth * 
o Staff Code *  (first three letters of your surname and your first initial) 
o ID Number (E code)* 
o Staff Type  

 

Note:  * indicates the field is mandatory 
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Contacts 

 Click on the Contacts tab to enter the details of a next of kin contact  

 Click Add Staff Contact   

 Enter details for a contact  
 

 
 

 Click OK  

 Place a tick in each of the Emergency and Next of Kin checkboxes  
 

UDI – Teacher Registration Board WA Number 

All teachers who are teaching in Western Australian schools are required to be registered with the 
Teacher’s Registration Board WA.  The TRBWA number issued to the teacher must be recorded in 
the UDI field for each teacher. 
 

 Click on the UDI tab 

 Double Click on TRBWA Number or highlight TRBWA Number and click on Edit UDI  

 Enter the TRBWA number  
 

 
 

 Click OK to save 
 

 Click OK to save the Staff Details entered 
 

Note: The Working with Children Check will be managed through HRMIS.  
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6 Administrator Tasks  

6.1 Setting up New Users  

 

General > Control > Users 

 Highlight the user ABBOTT 

 Click Clone User   
 

 

Note: Users who require Administrator Status can have that box checked when Cloning. 
Access Rights will not expire when the user has administrator rights. 

 Enter your user name  

 <Tab> 

 Enter the password as Password  

 <Tab> 

 Confirm the password  

 <Tab> 

 Enter your title, initials, full name and position, <Tab> between the fields  
 
If the new user is a teacher, his or her account must be linked to the information entered in Staff 
Details. 
 

 Click Find Staff Member   
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 Enter the first three letters of your surname in the Name/Number field 

 Click Find 
 

 
 

 If necessary, Select your name from the list 

 Click OK to save the new user account  
 

Note: The school’s system administrator user name is SCHADM.  This is the default 
account, and you must not delete it from the system. The user name ADMIN is used by 
Civica for support purposes and the user name EDWA by DoE.  These should not be edited 
or deleted. 
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6.2 User Access Rights 

6.2.1 Setting up User Access Rights 

Activity 

General > Control > Users 

 Double click on Elaine Abbott  

 Click on the General folder and highlight Student Details 
 

 
 
Elaine currently has Read Only access 
 
 



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 34 of 218 

© 2019 Civica Pty Ltd 

 

 

 Double click on Edit Activity  to grant her access to Students’ activities 
 

 
 

 Highlight Staff Details 
 

 
 

 Click  

 Click OK 
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6.2.2 Copying Access Rights 

Activity 

General > Control > Users 

 Click Copy Access Rights Between Users   

 Highlight ABBOTT in the left pane and ALAN, BEST and BRIGG in the right pane 
 

 
 

 Click OK  
 

 
 

 Click Yes 
 
The users Alan, Best and Brigg now have identical access rights to the user account Abbott. 
 

Note: The Clone User function  allows for cloning of access between individual staff at 
your school.  This is particularly useful when setting up a new user who will have exactly 
the same access rights as a user already on the system.  

Use the Copy function  to copy access from one user across to more than one user.   
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6.2.3 Making User Accounts Inactive 

Activity 
 
Angela Moore has left the school. User accounts cannot be deleted but can be made inactive. 

General > Control > Users 

 Highlight the user account MOORE in the System Users list 

 Click Edit User  

 Uncheck Active 

 Click OK 

 Uncheck Show active accounts only 

 View inactive accounts in the list 
 

 

6.2.4 Resetting User Accounts 

Activity 
 
In the event of a system crash it may be necessary to reset a user’s account.  For example, 
there was a power failure when Carl Best was logged in.  When he tried to log in again, the 
following message appeared: 
 

 
 
Carl Best’s account will need to be reset.  

General > Control > Users 

 Highlight Carl Best in the Users list 

 Click Reset User    
 

 
 

 Select Yes to the warning message 

 Close the window 
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6.2.5 Resetting All Users 

Note: From Integris version 6.96 the resetallusers function runs on the first Integris login of 
the day, meaning all users will be automatically reset each day. 

Activity 
 
In some circumstances, it may be necessary to manually reset access for all users.  For 
example, if there was a power failure and all users are locked out of the system.  In this 
instance, it would not be possible to make a backup; however, standard backup procedures 
should be in place. 

File > Single User Lock 

 Enter the password keys 

 Click OK 

 View the locked message and click OK 
 

 

File > Gateway 

 

 Enter the text resetallusers 
 

 
 

 Press <Enter> 
 

 
 

 Click Yes  
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 Click OK  

 Restore Multi-user 
 

 
 

 Enter the password Keys  
 

 
 

 Click OK 
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6.2.6 Audit 

System administrators are able to print an Activity Log, detailing everything that has been done on 
the system.  
 

Activity 

General > Control > Audit  

Viewing the Activity Log for a Date Range 

 
 

 Select All Users and TODAY as the date range 

 Click OK 

 Close the Activity Log  
 

Purging an Activity Log (Discussion Only) 

Purging the Activity Log is part of the Administration End of Year processes. This will be covered 
later in training. Purging an activity log removes the log entries from the system and the purged 
entries are then saved in an Audit log file.   
 
Clicking Purge, then Yes to the two messages allows you to save the purged files. These files 
would be named Audit Log with the year and defaults to save in the Outbox.  
 
K: /keys/Integris/Outbox 
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7 Student Details 

General > Student Details 

Student Details display comprehensive information about each student attending the school.  From 
the General side bar, choose Student Details.  The following window will appear: 
 

 
 
This is the summary window and displays the basic student data and a photograph of the student 
(where available).   

Photos are accessed by clicking on Display Student Photograph  at the bottom right-hand 
corner of the window. 
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Student Details Toolbar 

 
 
This drop-down menu enables the user to decide which of the rolls they wish to view. The available 
options are the Admissions Roll, Current Roll, Former Roll or the External Roll. 
 

  The Next Student and Previous Student arrows on either side of the binoculars allow 
you to scroll through the database either forward or backward in alphabetical order.  

  The Find Student tool enables users to find individual students or groups of students based 
on selected criteria.  
 
To view specific areas of a student’s record use the buttons on the tool bar at the top of the 
Student window: 
 

  Add a new student  

  Edit student data 

  Move a student to the Former Roll 

  Print student details  

  Send a letter 

 Send an e-mail  

  Summary details 

  Additional details 

  Movement History 

  Attendance History  

  Groups 

  Student Activity  

  User-defined Information 

  Medical Details 

  Teaching Sets  

  Miscellaneous details 

  Student timetable 

  Cohorts 
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Student Status Bar  

 
 
The Student Status Bar is designed to be visible from all panes of the window, giving users a view 
of key student indicators at a glance. 
 
The Status Bar is split into two sections, with the left-hand section reserved for more sensitive 
data.  In both sections, information on the current student is displayed using icons.  Hover the 
pointer over an icon and it will display a description of its meaning. 
 

Normal Bar 

 Student has a flagged medical condition 

 Language Background other than English 

 Access restriction 

 Part-time student 

 Accepted (Admissions Roll) 

 VET Student 

 Student Notes 

 Name Change 
 

Sensitive Status Bar 

 Educational Support Program 

 Excluded (Former Roll) 
 

Activity 
 

 View each of the screens in Student Details 
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7.1 Locating Student Records 

General > Student Details 

There are five methods of searching for students in Student Details 
 

 Using the Previous Student/Next Student arrows 

 Using Quick Search 

 Making Siblings the Browse set 

 Using the Find  

 Using the Advanced Find Student Search  
 

7.1.1 Using the Previous Student/Next Student Arrows   

The Previous Student/Next Student arrows are located at the top left of the Student window.   
 

 
 
They can be used to scroll through the current browse set of students.  

Click on the Next Student arrow  to move to the next student in the browse set. Click on the 

Previous Student arrow  to move to the previous student in the browse set. 
 

7.1.2 Quick Search    

The Summary screen in Student Details provides a Simple Student Search facility to enable the 
user to quickly locate and load a specific student’s record. It is located at the bottom left corner of 
the Student window.   
 

 
 
The search operates on the currently defined browse set in the Student Details window. If no 
browse set is defined, the currently selected roll will be searched. 
 

Activity 

General > Student Details 

 Place your cursor in the Search box or tab to the field to activate it  

 To search for a student Kane Smith enter the following:   

 Press <Enter> 
 
The Student Details screen for Kane Smith is displayed. 
 

 

 Use the Search to locate William Green’s records 
 

 Repeat to locate Jackie Albert’s records 
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7.1.3 Make Siblings the Browse Set  

Once a student’s record is loaded and any necessary changes have been made, it is easy to 
create a browse set of the student’s siblings so that the sibling’s records can be edited.  In the 
Contacts pane, right click and select Make Siblings the Browse Set.  
 

Activity 

General > Student Details 

 Right click in the contacts pane for Jackie Albert 
 

 
 

 Select Make Siblings the Browse Set 
 

 Indicates that a Browse Set (a subset of student records) has been created. 
 

 Click Next Student  
 
Jennifer Zolter-Albert’s records will be displayed. 
 

 Click Previous Student  to return to Jackie’s records 

 Click  and Yes to clear the browse set 
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7.1.4 Find Student Function   

Another method of finding a student’s record is by using the standard Find Student function located 
at the top of the Student window.  
 

 
 
This function is used in other sections of Administration Manager and in other Integris modules.  
 
Use the Find Student tool to select students by a variety of different search criteria. Click on the 
Find Student icon and the following window appears. 
 

 
 
Find a particular student by entering either a surname or Student Reference number in the 
Name/Number field.  It is not necessary to enter the whole surname.  Enter the first few characters 
and press <Enter>.  A list of students names matching the characters entered will be displayed.  
Double click on the appropriate name. 
 
You can find individual students or groups of students by many other criteria such as year group, 
form, teaching set, group, previous school, indigenous status, dates (including birthdays and 
student’s ages), addresses and user-defined information (UDI). 
 
The system can save any search criteria you enter - this is called a Query. A query can then be 
used at a later date to save you setting up the search again. 
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Activity  

Find the students in K/P Form 

 Choose Form: K/P  from the Year Group drop down menu 
 

 
 

 Click Find or <Enter> 

 Click on the Year header to sort by Year level 
 

 
 

 Click on Print  to print a list 
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Find students using Surname and Roll Status 

 Find the student with the Surname Fuller 

 Change the Roll Status to n/s to search the Admission, Current, Former and External Rolls 
 

 
 

 Click Find or <Enter>     
 
We can see he has been moved to the Former Roll 
 

 
 

 

Find students In Care of DCP 

 Click on the Dates Tab 
 

 
 

 Click Find or <Enter> 

 Click Back and clear your settings  
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Find students with a Health Condition 

 Find the students who have an Allergy – Anaphylaxis 

 Click on the Other tab 
 

 
 

 Click Find or <Enter> 

 Click on Print  to print a list 

 Click Back and clear your settings  
 

 

 Find the students who are the Family Representatives 

 Click on the Address Tab 

 

 

 Click Find or <Enter> 
 

 Click Back and clear your settings  
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 Find the Students with an Access Restriction 

 Click on the Parameters Tab 
 

 
 

 Click Find or <Enter> 

 Click Back and clear your settings  
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7.1.5 Saving and Loading a Query 

Activity 

Find students by Teaching Set 

 Find the Female students in 9ENG English 9 
 

 
 
 

 
 

 Save  this query 
 

 
 

 Give it an appropriate name and click OK 

 Click Find or <Enter> 
 

 Close the Student Search window 
 

 Click Find Student  

 Click View the Query List  
 

 Highlight 9 English  

 Click Load and Find to locate the students matching the query 
 

 
  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 51 of 218 

© 2019 Civica Pty Ltd 

 

7.1.6 Advanced Find Student Search  

When searching for students, the Advanced Find Student Search tool can be used to add another 
student or group of students to an existing search results list. 

For example, a normal student search could be performed using the   tool.   

Once the desired list of students is displayed, the Advanced Find Student Search tool  could 
be used to add more students to the existing list. 
 

Activity 

Find the Year 8 and 9 Boys 

 Click Find  

 On the General tab, select Year Group: 8 
 

 
 

 In the Parameters tab, select Gender: Male 
 

 
 

 Click Find or <Enter> 
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 Click Advanced Find  to search for the additional students to add to the query 

 Click Add Students  to find for the Year 9 boys  
 

 
 

 Select the Parameters tab and Gender – Male 
 

 
 

 Click Find, Select and Yes 

 This will add the Year Nine boys to the Year 8 list 
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 Click on the Form column header to sort into Forms 
 

 
 

 Click Print  and send the report to the screen 

 Close the report 
 

 Click Select and Yes to create a browse set of Year 8 and 9 boys 

 Clear  the browse set by clicking on  
 

 

Note: There is currently no ability to save advanced searches. 
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7.2 Entering and Maintaining Student Records 

General > Student Details 

7.2.1 Entering a New Student’s Details  

 Students can also be entered onto the Current, Admissions, Former or External rolls by 
selecting the appropriate roll and clicking Add Student.  
 
The minimum information the system requires is Surname, First Name, Date of Birth, Gender, 
Reference Number (automatically generated if Auto Number is selected in Control > Preferences > 
Defaults) and Entry Date.  Any other information can be added at a later date by editing the record. 
 
Where Timetabling is also loaded, the following window will appear at the conclusion of the Add 
Student process: 
 

 
 
Click No for primary students and Yes for secondary students where the Timetabling module is 
being used. Allocate the students to a cohort.  This prompt does not appear when adding students 
to the Admissions Roll.  The Timetabler may place children on the Admissions Roll into a cohort 
via Timetabling > Timetable Setup. 
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Activity 

General > Student Details 

Joshua Burnett is enrolling in West Coast High School today.  Enter his details as outlined below. 
 
Refer to Administration Manager – Supplement for Joshua’s enrolment form. 
 
 

 Click Add Student   

 Type Burnett in the surname field and <Tab> 

 Click Cancel when the Choose siblings window appears 

 Enter Josh’s personal details from the enrolment form  

 Joshua Burnett has no siblings at the school, so mark him as the Family Representative 
 

 
 

 You may place him a House of your choice 
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Family Group Tab 

 Click the Family Group tab 

 Enter his mother’s details in Parent/Guardian 1 

 Check the boxes for Parent Responsibility, Student Resident, Fees Billing and Family 
Mail Marker 

 Click  to mark her work phone number as the Primary Contact Number.  
 

 

Note: When entering the Salutation for multiple parents ‘and’ must be used rather than 
‘&’. 

 Click Add Notes  on the bottom right 

 Enter her work information  
 

 
 

 Click OK 
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 Click the Additional Details  
 

 
 

 Tab to enter MCCETYA (parents background information) for Parent/Guardian 1 
 

 
 

Parent Guardian 2 

 Click the Parent/Guardian 2 tab and uncheck No Parent/Guardian 2 for this student 

 Enter the step father’s information 
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Other Contacts 

 Select the Other Contacts tab and click Add Contact  

 Enter the Aunt’s information and click OK 

 Flag her as being emergency number 3  
 

 

Additional Information 

 

 Click the Additional Information tab and tick the Australia Citizen/Permanent Resident box 

  Enter the additional information shown below 
 

 
 
 

  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 59 of 218 

© 2019 Civica Pty Ltd 

 

Movement History 

 Select the Movement History tab and click Add  

 Enter the To date as last Friday 

 Enter the previous School and Reason 
 

 
 

 Click OK 
 

Medical Details 

 

 Click the Medical tab  

 Select the Medical Practice 

 Enter the Doctor’s Name 

 Tick the SHCS to be shared box 

 Tick the SHCS Completed box and add today’s date 
 

 
 

 Click on the Medical Details tab 

 Enter the following details 
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Miscellaneous Details 

 

 Click on the Misc tab 

 Select the Disability, Autistic spectrum disorder 

 Add the Detail as Autism 

 Tick the Evidence Provided box and Today’s date as the Date Checked 

 Add the Vaccination Information of Up To Date  

 Untick the Measles Exclusion box 
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UDI Details 

 

 Click on the UDI tab 

 Double Click on the Main Category of Disability 

 Select Cognitive and Click OK 
 

 
 

 Double Click on the Level of Adjustment Provided UDI 
 

  
 

 Select Supplementary and Click OK 
 

 Click OK to save  
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 Click Yes  to an entry date of today 
 

 
 

 Click YES, to add the student to timetabling 
 

 Ensure you have 2019 as the current year  

 Highlight 07 in the left window 
 

  
 

 Move to the right using  

 Click OK to save 
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7.2.2 Immunisation Notes 

 
Parents must provide their most recent copy of the ACIR (Australian Childhood Immunisation 
Register) Statement on enrolment. The school should take a copy and file this statement. If 
parents do not have an ACIR statement, then Not provided should be selected.  
 
When a student has a blank Vaccination Schedule, the following message will display.  
  

 
 
The warning message will not stop a new record from being created or stop an existing 
enrolment record from being edited, however it will advise the user that they must select one of 
the 6 options available from the Vaccination Schedule drop down list. 
 
Clicking on the blue hyperlink with take you to the DoE website to the Guidelines for 
Recording and Managing Student Immunisation Data document. 
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7.2.3 Adding a Student and Copying Family Information  

Activity  
 
David Allen has transferred from another school.  Add his details to the Current Roll with today 
as the Entry Date.  We will be able to copy much of his data from his sisters’ records. 
 
Refer to Administration Manager – Supplement for the enrolment information. 

General > Student Details 

 Click Add Student   

 Type Allen and press <Tab> 

 Highlight both Tamara and Penelope Allen  

 Click OK 

 Click Copy Data   
 
Address, Family Group and Additional information from the siblings will copy to the new record. 
 

 Enter the remaining data from the enrolment form 

 Click OK 

 View the Immunisation Warning message 
 

 
 

 Click No to continue and edit the record 
 

 
 

 Tick the Evidence Provided box 

 Enter Today’s Date as Date Checked 

 Select Fully Completed for the Vaccination Schedule 

 Uncheck the Measles Exclusion box 

 Click OK  
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 Click Yes to the Entry Date message 
 

 
 

 Click Yes to the Timetable message 
 

 
 

 Highlight 08 and click Add 
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7.2.4 Adding a Student to the External Roll 

Activity 
 
Justin Badely is attending PEAC at the West Coast Community College.  He needs to be added 
to the External Roll and flagged as a part-time student. 

General > Student Details 

 Select the External Roll  
 

 
 

 Select Add Student  

 On the Personal tab fill in the following information: 

o Surname: Badely 

o First Name: Justin 

o DOB: 24/3/2008 

o Gender: Male 

o Year: 7 

o Address: 125 Watershed Road, FORRESTFIELD, WA, 6587 

o Telephone: 9658 2154 

 

 On the Family Group, Parent/Guardian 1 tab fill in the following information: 

o Title: Mr 

o Initial: T 

o First Name: Travis 

o Relationship: Father 

o Gender: Male 

o Tick all four check boxes relating to parent information 

o Mobile Number: 0412 568 458 

o Salutation: Mr Badely 
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 On the Additional tab, check Australian Citizen/Permanent Resident   

 Set the FTE to 0.20  

 Select Custom 
 

 
 

 Click Assign Part Time Pattern   
 

 Set Tuesday and Wednesday mornings as the Attendance pattern 
 

 
 

 Click Close  

 On the Miscellaneous tab select Not provided for the Vaccination Schedule 
 

 
 

 Click OK to save 

 Return to the Current Roll 
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7.2.5 Editing Students’ Records 

General > Student Details 

Once a student has been entered on to the database, details may be added or edited at any time. 

To do this, find the relevant student and click Edit Student.   
 

Activity  

Changing a Student’s Name 

 Find Clay Karman 

 Click Edit  

 Change both the First Name and Preferred Name fields to William  

 Click OK 

 On the student status bar, click on Name History to view the changes  
 

Entering an Access Restriction 

 Find Nicole Lively 

 Click Additional  

 Click Edit   

 Check Access Restriction, then click on  to enter details of the Access Restriction 
 

 
 

 Click the  to close the details window then click OK to save the information entered 

 Check for the Access Restriction icon    in the student status bar. 
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Adding a Student Note 

 Find Michael Parker 

 Click Summary  

 Click Edit   

 Click Edit Student Notes  

 Add the note details 
 

 
 

 Close the note and click OK 
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7.3 Medical Records 

Medical Records are usually entered at Enrolment from the Student Health Care Summary Form. 
Records should be reviewed annually and any changes to a student’s health information must be 
updated.  

7.3.1 Entering and Maintaining Student Health Care Information 

Activity 
 

 Find Corrina Born’s records 

 Click Medical   

 Click Edit Student  

 Click SHCS Completed and enter today’s date 

 Check the box for the Standardised Plan of Severe Allergy Anaphylaxis 
 

 
 

 Click on the Health Care Planning tab  

 Click Add New Record   

 Select Allergy - Anaphylaxis and enter the information in the Daily Management Plan and 
Emergency Response Plan  

 Tick the box for all 5 requirements 

 Tick the box for Health Condition Flagged on the Status Bar and click OK 
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Note: Health Care Forms are located on the Department of Education website. They can be 
downloaded in either “.kst” or MSWord formats. To access or download the forms, follow 
the link below. Some Emergency Response Plans can be copied and pasted from these 
forms. 

Location of Health Care Forms: Behaviour and Well Being Website 
 
http://www.det.wa.edu.au/studentsupport/behaviourandwellbeing/detcms/portal 
 

 

 Click Open Medication details  

 Click Add Medication  

 Enter the information pictured below as well as an Expiry Date 
 

 
 

Click OK, then click  
 

 Click Open Staff Training details   
 

 
 
  

http://www.det.wa.edu.au/studentsupport/behaviourandwellbeing/detcms/portal
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 Enter the Type of training information  
 

 

 Click Add Staff member   

 Find Joseph Brigg and Elaine Abbott  
 

 
 

 Highlight one of the staff members and click on edit  
 

 
 

 Enter today’s date as the Training Date and a date one year ahead as the Retraining Date 

 Click OK  

 Click on Close 

 Click OK to save 
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7.3.2 Medical Reports 

There are several Medical Reports in Admin > Reports that can be used by schools to display 
Medical Information about students. 
 

Activity  

Admin > Reports > General Reports > Medical Details 

 Sort by Year Level 

 Tick all the boxes 

 Click New Query and Find Select and Yes to load all students on the Current Roll 
 

 
 

 Click Print 
 

 

Note: By selecting the option to ‘Only include students with ‘flagged’ health conditions’, 
and then selecting your whole school, this report will only print those students who have 
their condition flagged on the Status Bar. 
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Activity  

Admin > Reports > General Reports > Medication Report 

 Sort by Form then Year 

 Click New Query 

 Find All Current students 
 

 
 

 Click Print 
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Activity  

Admin  > Reports > General Reports > Health Care Conditions Review Date 

 Select Plans ALL. 
 

 
 

 Click Print 
 

Notes: [All students with a Health Care Condition Plan will be selected for the Report] 

Entering From and To Dates will allow filtering to include only students who have 
Completed Dates and Review Dates entered in the report window 
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7.4 Student Photographs 

You can add photographs to student records if the students are on the Current Roll. The 
photographs are not contained within the main datafile but are instead linked from a location 
specified within the General > Control > Preferences. The default path at school is: 
K:\Keys\Integris\Photos. 

Note: Only photographs of current roll students can be displayed. 

Scan the required photographs using a scanner and its associated software or use a digital camera 
to take student photos.  Alternatively, you may already have the photographs saved to a disc. 
 
Save the photos (files) with the following structure: {student number}.{format}, for example, 
324.jpg, where a student number is the same as the student reference number, and the format is 
the format specified on the images tab in Preferences (e.g. jpg) 

Note: Images can currently only be held in the JPG format.  

7.4.1 Linking a Student Photograph 

Activity 
 

 Navigate to C:\Keys\Integris\Photos  

 Find file Haylee_Marlin.jpg  

 Right click and choose Rename.  Type in the new filename as the reference number168 
making sure you click out of the field or press enter once the 168 is inserted. 

 
 Close the window 

General > Student Details  

 Locate Haylee Marlin’s records 

 Click Display Student Photograph  
 

 Close Student Details 

Note: These files need to be .jpg files. On these training computers, the file extension 
(.jpg) is hidden. 

 

  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 77 of 218 

© 2019 Civica Pty Ltd 

 

7.4.2 Student Photo Report 

A Report is available in Admin > Reports > Form Lists that will display student photographs. 
Reports can be displayed by Form (default setting) or by Year Group or Student Find. 
 

Activity 

Admin > Reports > Form Lists > Student Photos 

 Select Form 8.1 
 

 
 

 Click Print 
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7.5 School Curriculum and Standards Authority (SCSA) Student 
Numbers 

School Curriculum and Standards Authority Student Numbers (Previously Curriculum Council 
Numbers) can now be assigned to students up to and including Year 7’s through the Admin > 
Utilities window. 
 
A Text file can be obtained from the School Curriculum and Standards Authority (SCASA) to use in 
the Import Utility. 
 
 

7.5.1 Student Numbers - Validation Information 

 
The text file contains a list of Student Numbers to be imported.  An example Student Number 
import file is shown in the figure below. 
 

 
 
The selected import file has the following validation to check it meets the agreed format and follows 
the rules described below. 
 

 Each line must be a numeric field of length 8 and must not start with a zero. 

 Any Student in Year 7 who already has an 8-digit Student Number is ignored; the existing 
Student Number is retained and NOT overwritten by a number in the import file. 

 If a Student Number in the import file is already assigned to a student in the data file, then that 
number is ignored and not assigned to another student. 

 

 
 
Clicking OK will result in the allocation of the Student Numbers to the selected Year level. 
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7.5.2 Student Number Import 

 
Opening this Utility prompts the user to select a Year level to which the SCSA Student Numbers 
will be applied. 
 

Activity 

Admin > Utilities > Student Number Import 

The  new Year 7’s and existing Year 8’s do not have a SCASA Student Number 
 

 
 

 Select Year 7 from the drop down list 
 

 
 

 Click OK 
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 Click Yes 

 Navigate to C:/keys/Integris/Inbox/StudentNos 

 Highlight the 7CCNos text file and click Open 
 

 
 

 Click OK to the Validation message 
 

 
 

 
 

 
 

 Click OK 

 Repeat for the Year 8’s 

 View the Year 7’s  and Year 8’s SCASA Student Numbers through Student Details 

Note:  Secondary schools will need to import both Year 7 and Year 8 SCASA numbers 
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7.6 Student Emergency Contact 

The Emergency button can be used to quickly display all relevant information on a student or staff 
member in the event of an emergency.  
 
Located in the top left-hand corner of the screen and present at all times the software is open, you 
will see the two Emergency Contact buttons for Students and Staff.  
 

 
 
Click on an icon to load the standard Search window, enter a student or staff member’s name and 
load their data. The Emergency Contact window will open. The following example is for a student. 
 

 
 
Student emergency information can also be accessed via the Emergency icon on the Admin 
sidebar.  
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7.6.1 Viewing and Printing Emergency Contact Information 

Activity  

Print emergency details for Penelope Allen 

 Click Student Emergency Contact   

 Enter ALL in the Surname/Ref. No. field and click Find  
 

 
 

 Highlight Penelope Allen and click Select 

 Scroll through the Contacts using   

 Print  the report to the screen 

 Close the print screen and Emergency Contacts 
 

Print emergency details for a Staff Member 

 Click Staff Emergency Contact   

 Enter Your Surname in the Surname/Ref. No. field and click Find  

 Scroll through the Contacts using   

 Print  the report to the screen 

 Close the print screen and Emergency Contacts 
 

 
  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 83 of 218 

© 2019 Civica Pty Ltd 

 

8 The Admissions Roll 
During the course of the year, it will be necessary to enter details for students who may be 
admitted to your school at any time in the future. These students are entered on the Admissions 
Roll. This can be done in one of three ways. 

Entering Data Directly onto the Admissions Roll 

To enter admissions in this way, select the Admissions Roll in Student Details.  Click on the Add 
Student button and enter data in the normal way. 

Entering Minimal Data via the Admissions Batch System 

Admissions can also be entered via the batch system.  This is a fast way to enter only the most 
basic information required for each admission.  It is seldom used as it enables so little data to be 
entered. 
 

  
 

Advanced Admissions Entry (from Admissions Batch screen) 

This function enables users to rapidly enter much of an Admissions student’s data, by tabbing 
through all the fields. 
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8.1 Admissions Roll 

Madeline Crean is enrolling for next term.  Her half-sister Helen Baverstock is already enrolled at 
the school.  We can enter Madeline on the Admissions Roll and copy her data from her half-sister 
Helen.  
 

Activity 

General > Student Details 

 Select the Admissions Roll 
 

 
 

 Click   
 

 Enter Madeline Crean’s last name in the Surname field 

 Press <Tab> to move between the fields and the Choose Sibling window will display 
 

 
 

 Use Student Find  to locate Helen Baverstock 
 

 
 

 Copy Helen Baverstock’s details using    
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 Enter her First Name 

 Enter her Date of Birth and Gender 

 Enter her Year  

 Click OK to move her from one Lesson Attendance Period Structure to another 

 Enter her Form Room as 07.1 

 Tick the Accepted box 
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 Click the Additional tab, check Australian Citizen/Permanent Resident  
 

 
 

 Click OK 
 

 
 

 Click Yes to Save without entering the Vaccination Schedule 

Admin > Utilities 

Madeline has now arrived at school, so we will transfer her to the Current Roll 
 

 Double-click Admissions Transfer  Current Roll 
 

 
 

 Select the second option (ignoring Entry Dates) and leave today as the entry date. 

 Click Next   

Notes:  If Option one is selected, only those accepted Admissions students whose Entry 
Date matches the date of entry will be transferred to the current roll. 

If the second option is selected, ALL accepted Admissions students will be transferred to 
the Current Roll and any Entry Date previously entered will be ignored and be replaced by 
the date entered in this window. 
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 Click Finish 
 

 
 

 Click OK to the Transfer Complete message 
 

 
 
 

 Click No as you do not wish to check for Empty Batches  
 

Note:  Speed Edit may be used to edit Acceptance Status (Admissions) for more than one 
student. 
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9 The Former Roll 
Students may be moved from the Current to the Former roll individually or in groups. 
 

9.1 Moving an Individual Student to the Former Roll 

Activity 

Linda So is leaving the school today.   

General > Student Details 

 Use Search to find Linda So  

 Click on Move Student to Former Roll   
 

 
 

 Click Yes 

 Leave the Leave Date as TODAY and enter the following details for Destination and 
Reason for Leaving 

 

 
 

 Click OK 
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 Select TODAY’S date for changes to the roll status 
 

 
 

 Click OK 

 Remove her from her cohorts by clicking   
 

 
 
Where students are enrolled in classes (Teaching Sets) in the timetable the following message 
will display. 
 

 
 

 Click Yes 

Note: Removing students from their cohorts in this way, enables the Timetabling 
module to keep a record of their teaching sets. This report can be accessed in 
Timetabling > Reports > O&M Reports-Students > Re-admissions Form 

Linda’s records have now been moved to the Former Roll. 
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9.2 Moving Groups of Students to the Former Roll 

If several students are leaving the school (for example, a family group) it is faster to use the 
‘Current Roll to Former Roll’ utility.   
 

Activity  

Cameron and Kane Smith are moving to Jurien DHS.  Move them to the Former Roll. 

General > Student Details 

 Use Search  to locate Cameron’s details 
 

 Right click in the Contacts pane and select Make Siblings the Browse Set 
 

 
 

 Click Edit  

 On the Additional tab, enter a Leave Date of TODAY and the destination of Jurien DHS 
 

 
 

 Click OK 

 Scroll to Kane’s records 

 Enter the same details in his records  

 Close Student Details 
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Admin > Utilities 

 
 

 Double-click Current Roll  Former Roll 
 

 
 

 Enter TODAY’S date as the student’s Leave Date 

 Click OK  

 Click Yes to remove them with today’s date 
 

 
 

 Click Yes 
 

 
 

 Click OK 

General > Student Details  

 Locate Cameron and Kane Smith on the Former Roll 
 

Note: Removing Students in this way does not allow users to save a copy of a student’s 
Teaching Sets. 
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9.3 Reinstating Former Students 

To work with former students you must first select Former from the drop-down roll menu at the top 
left of the Student window.  This will display only Former student’s records.  If you are using the 
Student Find to locate a student on the Former Roll, remember to select Former in the Roll Status 
field when entering your search criteria.  
 

 If you wish to reinstate a student who has been transferred to the Former Roll, you can do this 
by clicking Reinstate Student to Current Roll. 
 

Activity 

General > Student Details > Former Roll 

Leif Campbell is transferring back to the school from Moerlina School. 

 Find his records on the Former Roll  

 Click Edit  

 Update his Year to 4 and his Form to Room 4  

 Click OK 

 Click on Reinstate Student to Current Roll  

 Click Yes to confirm that you wish to reinstate him 

 Click Yes to confirm his year and form to re-enter 

 Enter his Entry Date as TODAY 

 Leave his Previous School as Moerlina PS  
 

 
 

 Click OK 
 

 
 

 Click Yes 

 Select No, as we will not be adding Leif to the Timetabling Module  

 View Leif’s details on the Current Roll  
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10 Exporting and Importing Student Data 
It is possible to electronically export and import student data without losing any information or the 
information being overwritten. 
 
When student data is received from another school, you are given options regarding the retention 
of the data that already exists in your datafile.  There are three checkboxes available in the Import 
Transfer File window. These determine how the data is matched to student records that exist in the 
datafile, as well as what data is retained or overwritten according to the selections made. 
 

 
 
Replace all Contacts and related detail when updating existing Students – recommend 
leaving this un-checked.  If the student already exists in the datafile, it is unlikely that the details in 
the import file are more current than those in your datafile, unless the student has been reinstated 
from the Former Roll and not had their contact details updated. 
 
Match Students on UPN only – recommend leaving this unchecked. 
 
Extended Checking – recommend checking this box.  This function will look for similarities 
between student records based on a combination of gender, date of birth, the first two letters of the 
first name and the first two letters of the surname.  When a potential duplicate has been found, the 
Extended Checking window will display.  The window provides the user with options for importing 
or rejecting the student record.  During processing, an activity log displays the progress of the 
import of each record.  The activity log can be saved or printed. 
 
Student data can be transferred from primary to secondary schools well before the end of the 
academic year.  This enables the secondary school to undertake activities associated with the 
creation of the following year’s timetable and in producing a charges and contributions sheet. 
 
In all cases, students should be enrolled onto the Admissions Roll and then transferred to the 
Current Roll upon arrival at the destination school. The exception to this rule is only if the student 
already exists in the datafile, either on the Former or Current Roll 

Items in the Transfer File include: 

 Student personal details (entry date, address, DOB, etc) 

 Student additional information (Indigenous Status, religion etc.) 

 Medical information (sensitive information is not included and a message is displayed 
indicating the student has a flagged medical condition) 

 Contact details for parents and emergency contacts 

 Previous school (if entered when importing the data) 

 Behaviour records (If using the XML Export Utility, schools may elect to export ALL Behaviour 
Records or only those marked as Retain on Transfer)  These records will be in Grey in the 
Behaviour Management screen for the student  

 Attendance records summary 

Note: Student Photos are not included in the Import/Export process.  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 94 of 218 

© 2019 Civica Pty Ltd 

 

10.1 Exporting Student Data 

Activity 

Admin > Utilities > School to School Export 

 
 

 Enter the Destination of Jurien DHS and TODAY as the Date of Leaving 

 Check each of the export options 
 

 
 

 Click OK 
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 Give the export file a name, for example West Coast DHS to Jurien DHS_Smith family 
 

 
 

 Click Save 

Note: This is the DoE recommended protocol for naming Student export files. 

 
 

 Click Yes 
 

 
 
 

 
 

 Click OK 
 
The export file may now be sent to the destination school as an email attachment.  It would be 
helpful to provide the school with a list of the students whose data is being exported. 
 

 Close the Transfer window by clicking Cancel 
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Admin > Utilities > Student Details XML Export 

 
 

 Click  
 
Enter the following information to locate Linda So 
 

 
 

 Click Find 
 

 
 

 Click Next 

 Schools can elect to create a Full or Partial Export from the Student Details XML Export 
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 Choose the Partial Export option 
 

 
 

 Enter the Destination of Northampton D.H.S  

 Click Export 
 

 The export file should be Saved to the outbox 

 Give the export file a name, for example West Coast DHS to Northampton DHS_Linda So 
 

 
 

 Click Save 

 Click Yes to recalculate the Attendance figures 
 

 
 

 Click OK 

 Close the Transfer window by clicking Cancel 
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10.2 Importing Student Data 

10.2.1 Importing Student Data to the Current Roll 

Activity 

Admin > Utilities > School to School Import 

 
 

 Select the transfer file for Tapping PS to West Coast DHS_Joshua Burnett and click Open 

 Change Import into the Current Roll (as we have entered him onto that roll) 
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 Check Extended Checking (this ensures that possible duplicate records may be displayed) 

 Click OK 
 
The Extended Import Checking for Possible Duplicates window appears, showing any possible 
duplicate students that the important function has found. 
 

 Highlight the Similar Student shown 

 Select Import into the selected existing student record, retaining the existing core 
details 

 

 
 

 Click OK 
 

 
 

 Click OK and Close 
 

General > Student Details 

 Check that Joshua Burnett's information has been updated and that he now has a Lesson 
Attendance History. 
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10.2.2 Importing to the Admissions Roll 

Activity  

Admin > Utilities > School to School Import 

 
 

 Highlight the transfer file for Ravensthorpe to West Coast_Alan Grant.xml and click Open 

 Select the Admissions Roll  

 Click  

 Enter the following 
 

 
 

 Click OK 
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 Leave the Entry Date as TODAY 

 Extended Checking option is ticked by default (Do not change) 
 

  
 

 Click OK 
 

 
 

 Click OK at the conclusion of the import process 

 Print the import log to the screen  
 
At school, this information could be saved as a hard copy of the import routine. 
 

 Close the Import Log and Utilities 

 View Alan Grant’s records on the Admissions Roll.  

 Check the Movement History  
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11 User Defined Information 
Within student records there is a section called UDIs.  This is used for storing any information 
specific to your school that does not already have a field in Student Details.  It could be anything 
from Student Photo Publication Permission to SmartRider Permission.  Any Student fields that you 
set up as a UDI can also be used to report on and find students. 
 
It is also possible to set up and maintain Staff and School UDIs.  

11.1 Creating a UDI 

Note: To create a UDI, it is necessary to be in Single User mode. 

We wish to create a UDI field to record whether students have permission to use the internet at 
school. 
 

Activity 
 
File > Single User Lock 
 

 
 

 Enter your password  
 

 
 
If other users are logged on to Integris, their details can be displayed via the View Users button 
so that the administrator can ask them to exit the system. 
 

 Click OK 
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General > Control > UDI Definitions 

 
 

 Double click Student UDI 

 Right click in the white pane under the Field Name heading 
 

 
 

 Select Add Field  

 Enter the Field Name:  Internetaccess 
 

 

Note: Field Names cannot have spaces. 

 Press <Tab> 

 From the drop-down menu, select Lookup 
 

 
 

 Click Edit  

 Type Yes, <Tab>, No. <Tab>, Restricted (See Student’s File) 
 

 
 

 Click OK 
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 Enter: Internet Access in the Description field 

 Check the Index box 
 

 
 

 Click OK  
 

 
 

 Click Yes 

Note: While a UDI cannot be deleted, it can be edited or disabled. 

To return to Multi-user mode: 

 Click  
 

 Select Restore Multi-user 
 

 
 

 Type your password  

 Press <Enter> or click OK 
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12 Speed Edit 

Admin > Speed Edit 

Speed Edit enables users to edit a number of student records at the same time in order to make 
the process faster.  Speed Edit can be used to allocate House Factions, Current Forms, 
Acceptance Status, PG1 Fees Billers, Health cards and much more. 
 

Activity 

Speed edit the UDI Internet Access for all students in Year 6 

 Select **Student UDI Fields** from the Area menu 
 

 
 

 Select Internet Access  from the UDI Field menu 

 Find  and select the Year Group 6 
 

 
 

 Click Find, Select and Yes 

 Click on the New Value drop down arrow to view the Lookups 
 

 
 

 Highlight some of the students and select Yes 
 

 
 

 Click Apply Changes  

 Highlight some of the students and select No 

 Click Apply Changes   

 Highlight some of the students and select Restricted (See student’s file) 

 Click Apply Changes   

 Click Save and Yes  
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Some students have not provided their Vaccination Schedule to the school. Speed Edit may be 
used to flag those students who have not yet provided evidence of their Vaccination status. 
 

 Select the **Student UDI Fields** from the Area menu 

 Select the Vaccination Schedule from the UDI Field 
 

 
 

 Click  

 Select all the student on the Current Roll 

 Click Find, Select and Yes 

 Click on the  tab 
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 Select Not Provided from the New Value menu 
 

 
 

 Click Apply Changes  
 

 
 

 Click   and Yes 
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Country of Birth has not been recorded for most of the students in Year 2.  Speed Edit their 
records to show their Country of Birth. 

 Select Country Of Birth from the Area drop down list 
 

 
 

 Find  all the students in Year Group 2  
 

 
 

 Click Find, Select and Yes 
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 Highlight Kyle Amber  
 

 
 

 Select Albania from the New Value menu  
 

  
 

 Click Apply Changes   
 

 Click  
 

 
 

 Select Australia from the New Value menu  
 

 
 

 Click Apply Changes  

 Click Save and Yes  
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12.1 Ad Hoc Reports 

Admin > Reports > Ad Hoc Reports 

Users can create their own reports using Ad Hoc Manager.  
 

Highlight the Ad Hoc Reports folder and click on the  button that appears on the 
right-hand side of the window.  The Ad Hoc Manager window opens. 
 

 
 

To create a new report, click on the Ad Hoc Wizard.    This will take you through the Ad-Hoc 
Wizard function, asking you to select what data you wish to include in your report and how you 
wish to sort it.  Once you have progressed through all the Wizard windows you will be asked to 
create your report.  This takes all the fields you have specified and displays them in the design 
window, enabling you to make changes to the layout of the report: 
 

 
 
It is here that field lengths can be extended, text styles can be changed and fields can be 
rearranged and added to change the whole layout of the report. 
 
Closing the design window saves the set-up and brings you back to the Ad Hoc Manager window 
where all the reports created will be displayed. 
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Use the  buttons to change the view of the Ad Hoc Reports.   
 
 

 
 

 Modify Report   
 

 Copy Selected Report   
 

 Rename Selected Report   

Note: It is a good idea to copy a report and give it a new name before making any changes. 

Once reports have been defined, they are run in the same way as standard reports. 
 

 Open the Ad Hoc Reports folder 

 Highlight the report to be printed 
 

 
 

 Use New Query to load the Student Search window  

 Select students or load a saved query 

 Print the report 
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Activity 

Create an Ad Hoc report displaying student’s names, Forms and the UDI Internet Access.  
Sort by Form and display each form on a separate page. 

 Click on the text for Ad Hoc Reports  
 

  
 

 Click Ad Hoc Manager 

 Click Ad Hoc Wizard   

 Enter the following information 
 

 
 

 Click Next 
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 Check the following fields: 
o Form   
o Name: First Name 
o Name: Surname  
o UDI: Internet Access 

 

 Click Next 

 Leave the Selection Criteria as ALL 

 Click Next 

 Select the following Print/Sort Options: 
 

 

Note: Normally a Page break would be used for Form or Year for this type of report. 

 Click Next 

 Highlight Name: Surname and click Up to select the following print order 
 

 
 

 Click Next 

 Click Create  
 
The Ad-Hoc Designer window opens 
 

 
 

 Click the Form column header once (in bold) 

 Change the font size to 12 

 With Form still selected, click Text Colour  

 Double click and remove Name: from Name: Surname and Name: First Name  

 Continue to format the remaining column headers if required 
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 Close Ad Hoc Report Designer and Ad Hoc Manager  

 Open the Ad Hoc Reports folder  

 Select the report Internet Access Permission 
 

 
 

 Click New Query  

 Find the Year Group 6 students 

 Click Find Select and Yes 

 Print the report to the screen  

 Close  
 
 
 

 

Note: To make any further changes, close the report and return to Ad Hoc Reports > Ad Hoc 
Manager.  Double click on the report name to open it if you wish to modify the report. 
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13 Groups 
Groups of either staff or students can be set up so that it is easy to identify who are attending 
excursions, what clubs people are affiliated with, or for grouping students for assessment. 
 
Groups are categorised under Group Types which are set up within Parameters > Group Types. 

13.1 Group Types 

Activity 
 

General > Parameters > Group Types 

 Right click in the Group Types list 

 Select Add New Parameter 
 

 
 

 Enter 2019 Camps and click OK 
 

 
 

 Close Group Types and Parameters 
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General > Groups 
 

 From the Group Types menu, select 2019 Camps 
 

 
 

 Click Add Group   

 Enter a Group Description and check Parental Consent required 
 

 
 

 Click OK  

 Highlight the Year 8 Rottnest Island  and click Add Members  on the right 

 Find the Form Year 8.1 students and select some of the students 

 Highlight most of the students in the list and click Parental Consent given  
 

 
 

 Delete  from the list those students without parental consent 

 Print  the list of students on the Rottnest Island camp to screen 
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 Add  a second Group Year 10 Coral Bay and again check Parental Consent required 

 Click OK 
 

 
 

 Add some Year 10 students to the Coral Bay group 

 Indicate that these students have parental consent 
 

 Print  the list of students on the Coral Bay camp to screen 
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14 Review Maintaining Students Records  

14.1 Start of Day Two 

Activity 
 

Complete each of the following tasks and make a note of the pathway taken. 

1. Lynda Miller’ is on the Admissions Roll and has been accepted as a student at West Coast 
District High School. Edit her record to mark her as accepted, allocate her to a form (Room 
1) and move her to the Current Roll. 

 
 
 
 
 
 
2. Move Kevin Istan to the Former Roll.  He is leaving TODAY and going to Bunbury Senior 

High School. 
 
 
 
 
 
 
3. Export Kevin Istan’s records so his data can be sent to Bunbury Senior High School 
 
 
 
 
 
 
4. Print emergency contact information for Doyen Bailie. 
 
 
 
 
 
 
5. Three students in Form 8-2 have not been allocated to a House.  Use Speed Edit to put 

them into Houses. 
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15 Mail Merge 
Integris provides users with a letter writing facility as part of the Student, School and Staff Details 
sections of the software.  
 
There are two ways that Integris can create mail-merged documents.  

Option 1 

The first is by way of using mail merge fields available through the database.  The Integris 
database is supplied with a mail merge function whereby certain administrative details such as 
student’s names and addresses can be dynamically embedded into a MS Word template.  These 
can then be saved as school letters. The letter templates are created before using the Send Letter 
function in Student Details.  

Option 2 

The second way is to create an export file, which then allows users to use the MS Word mail 
merge functions to create their letters or other documents such as address labels, by linking to this 
exported data.  

Selecting Students and Merging System 

When you are ready to send a letter, decide to whom the letter will be sent. If the letter is to be sent 
for one student, load their records in Student Details.  If the letter is to be sent for a group of 
students, use the Find Student function in Student Details to create a browse set of students.  
When the user has selected the student/s in Student Details and the Send Letter button is clicked, 
a Mailing Options window is displayed. 
 

 
 
Make selections as appropriate.  If using the .kst method, the template has to be created prior to 
clicking Send Letter.   
 

  
 

Letters to be sent to all contacts flagged as Family Mail Markers: 

If *.kst file merging is being used, this may result in multiple copies of the letter being produced for 
each student, e.g. if more than one contact is flagged as Family Mail Marker. If a *.csv file is being 
exported, several record lines may be included in the file for each student (one for each Mail 
Marker contact). In this regard, tick the Family Mail Marker box to only have letters sent to the 
Parent/Guardian flagged as such. 
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Note: Other Contacts can be flagged as Family Mail Markers as well as Parent/Guardians. 

The Family Mail Marker field should be enabled if letters are to be sent to the person at this 
address. If you use this field, make sure you complete the Salutation. Enter the salutation that is to 
be used when writing a letter to this person. It is also displayed on some reports. 
 
If a student has details of both parents recorded, with only one parent/guardian nominated as a 
family mail marker. The salutation field will need to be completed for the nominated parent e.g. ‘Mr 
and Mrs Allen’. This will be available as a mail merge field to start a letter “Dear Mr and Mrs Allen”.  
 

Note: If letters are to contain Family Mail Marker information then the letter template must 
contain ‘Addee’ fields and the box ticked for ‘Send to all contacts marked as Family Mail 
Marker’ (see screenshots below). 
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15.1 Mail Merge: kst format 

Using the kst method, the user creates a letter template prior to selecting contacts to which the 
letter will be sent.  This method is useful for printing small numbers of letters.  If letters are to be 
merged for a large number of students, use the Export method (Option 2). 
 
Creating a kst Template  
 

 Open Microsoft Word 

 Click Open Document  

 Navigate your way to the K:\Keys\Integris\MMTPL\Letters folder 

 Open the Student.kst document that is supplied with the software.   
 
 

 
 
This can be used to copy merge fields into the letter template you are creating. 
 

 Open a new Microsoft Word document 
 
This will be used for the letter template. 
 

 Type the body of the letter. 

 Enter the merge fields for your letter template using the field names in the Student.kst 
document for any Integris fields you want included in the letter.  

 Save your document with .kst extension in quotation marks, for example  “Student Letter.kst” 
 
This letter template should be saved to an appropriate folder within your school network, for 
example to a shared drive where all templates are stored. 
 
When the template is complete, it will be available to all users with access to the drive where the 
template is stored. 
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Note: When creating .kst Templates, users are advised NOT TO USE Numbered Bullet lists 
as these will cause the Template to be corrupted. Numbers must be typed in, rather than 
inserted using Numbering or Bullet Lists. This issue is with MS Word kst Templates. 

 

15.1.1 Creating a kst Template 

Activity  
 
A copy of the sample transfer note can be found in the Administration Manager – Supplement. 
 

 Navigate to My Computer  - C:\Keys\Integris\MMTPL\Letters to open Student.kst 

 Minimise the Student.kst 

 Open the document Sample Transfer Note also located in 
C:\Keys\Integris\MMTPL\Letters  

 
Text has been entered but the merge fields need to be added. 
 

 Type Previous School above the black line 

 Copy <PrevSch> from Student.kst and paste it at the top of your Transfer Note 
 

 
 

Note: The Previous School field comes from the Movement History record for a student. If 
a Movement History has not been added against the student, the field will not populate. 
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Note: When typing in merge fields, they must appear exactly as they appear in 
Student.kst. 

 Continue to copy and paste, or type merge fields into your transfer note (Hint: Use the 
example in the Administration Manager Supplement on page 23). 

 When all merge fields have been added File > Save As 

 Enter the file name as "Transfer Note.kst" 
 

 
 

 Click Save 
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15.1.2 Using the kst template to create letters 

Activity  

General > Student Details 

Send Transfer Notes for the students who started at West Coast District High School yesterday. 
 

 Find  the students who started yesterday 

 Click on the Dates tab 

 Enter Yesterday’s and Today’s date in the Entry Date From and To fields 

 Click Find, Select and Yes 
 

 
 

 Click Send Letter  

 Select the following options 
 

 
 

 Click OK 

 Select Transfer Note.kst 

 Click Open 
 

 
 

 View the Transfer Notes before you click Yes to this message 

 Close the Transfer Notes  

 Click Yes if the Transfer Notes printed as expected. 
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Note: If there are problems with the merged document, you can close and re-open the 
original to make any corrections before running the mail merge again. 

 
DO NOT CLOSE WORD 
 

 Click Student Activity  

 View the new student’s records 

 Close Student Details 
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15.2 Mail Merge using CSV format 

General > Student Details 

The second mail merge option is to create an export file, which then enables users to use the MS 
Word mail merge functions to create their letters or documents.  This method is faster than the .kst 
method when creating merged documents for a large number of students. 
 
Find the student/s to which you wish to send a Letter  
 
This creates a browse set. 

 Click Send Letter  in the Student Details window  
 
The Mailing Options window opens.  
 
Select the CSV option 
 

 
 

 Click OK  
 

 
 

 Name the file and save it to an appropriate location 

 Click OK 
 
You have now created a file that can be used in Microsoft Word, or other word processing 
packages, to create forms, letters, labels or other merged items.  
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15.2.1 Creating an Export (.csv) File 

Activity  

General > Student Details 

 Find  the Senior Choir 
 

 
 

 Select All the  students from the list 
 

 Click Send Letter  

 Select the following options 
 

 
 

 Click OK 
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Note: The file will default to save in the Integris Outbox, however you can save it to your 
desktop or any other location.  

 
 

 Give the export file an appropriate name 

 Navigate to your desktop 

 Click Save and OK 
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15.2.2 Creating a Mail Merge Letter in Word – Using Letters 

Activity 
 
A sample letter can be found in the Administration Manager Supplement on page 22. 
 

 Open a new Microsoft Word document 

 Click on the Mailings Menu 
 

 
 

 Click on the small arrow at the bottom of the Start Mail Merge icon 
 

 
 

 Select Letters 

 Click on Select Recipients and choose Use Existing List 
 

 
 

 Browse to the csv file on your desktop 
 

 
 



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 130 of 218 

© 2019 Civica Pty Ltd 

 

 

 Highlight and Click Open or Double Click 

 Click the Edit Recipient List icon 
 

 
 

 
 

 Click OK for all recipients or select those required 

 You are now ready to start creating your letter 

 Place your cursor where you want the first address line in your document to appear 

 Click on the small arrow at the bottom of the Insert Merge Field icon 
 

 
 
All available Mail Merge fields will show in this list.  
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 Click on AddeeSalutation 

 Move your cursor to the next line 

 Click on the small arrow at the bottom of the Insert Merge Field icon 

 Click on AddeeAddL1 
 
Use the Sample on Page 25 of your Admin Manager Supplement to type a short letter for the 
Choir activity and insert all the Mail Merge fields as displayed. 
 

 Click Preview Results when you have completed your letter 
 

 
 

 You can preview other letters by scrolling through the recipients with the scroll arrows. 
 

 
 
If there are mistakes in your letter: 
 

 Click Preview Results again and make any changes required 
 
When you are happy with your letter: 
 

 Click on Finish and Merge 

 Select Edit Individual Documents 
 

 
 

 Click OK for All 
 

 
 

 View your merged letters 

 Close the letters but do not close word 
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15.2.3 Creating a Mail Merge Letter in Word – Using the Mail Merge Wizard 

 
If you are accustomed to using the Mail Merge Wizard available in Word 2003, the same 
Wizard can still be used. A summary of those steps are outlined below. 
 

 Select Step by Step Mail Merge Wizard from the Start Mail Merge Icon 
 

 
 
The Mail Merge Wizard will open on the right hand side of the document 
 

 
 

 Select the document you require and Click on Next: Starting document 
 

 
 

 Click Next: Select Recipients 
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 Ensure Use an Existing List is selected and click on Browse 
 

 
 

 Navigate to where you have saved your data source and Open the file 
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 View your Recipient List and select the recipients required and click OK 
 

 
 

 Click Next: Write your letter 
 

 
 

 To Insert Mail Merge Fields click on the link to More Items 
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 The available fields will display 
 

 

Note: Fields can be inserted by double clicking or highlighting and clicking Insert. If you 
need to re-position your cursor in the document, you must close this window, move your 
cursor and click on More Items again. 

Once you have inserted all your items and typed your document: 
 

 Click on Next: Preview your Letters 

 You can scroll through and view all recipients’ letters or edit the recipient list at this point. 
 

 
 

 If you find errors, click Previous: Write your letter  
 

 
 

 This allows you to return to the previous page to edit the letter. 
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 If you are ready to finish the Mail Merge: 

 Click Next: Complete the merge 
 

 
 

 Letters can be printed at this point. If you wish to open the letters as a new document: 

 Click on Edit individual letters 
 

 
 
You can open All Letters or select particular letters if you know which recipient you wish to edit. 
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16 School Details 

General > School Details 

The School Details window is very similar to that in Student Details and some of the icons are 
the same.  The main tools within School Details are: 
 
 
            
             

 
 
 
 

 
 
 
 

 
 
 
 

Edit School Details  enables the user to maintain details in all areas of the school’s details.   
 

Activity 

View each of the following windows in School Details. 

 Sites  

 Directory  

 School Activity  

 School Diary  

 Timetabling Periods  
 

 
 
  

Edit school 
details 

School user-defined 
information 

Display school 
details summary 

Maintain information 
about additional 
sites 

Maintain 
directory of 
contacts  

School 
activity log 

Print school 
details 

Send a letter 

Set up and 
maintain the 
school diary 

Set up timetabling 
periods 

Send an 
email 
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16.1 Entering Events in the School Diary 

Activity 

General > School Details 

It is possible to enter events that may be occurring at the school during the Term or Year and 
then print a Term or Year planner to display the up and coming events. 
 

 Select Display School Diary  

 Click Year View  

 Select YESTERDAY’s date 

 Click Add  

 Enter the following information and click OK 
 

 
 

 Click Recurring Events  

 Enter the following information  

 
 

 Click Generate and Yes 
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16.1.1 Printing the Term Planner 

Activity  
 

 Click Term View Report  

 Select the CURRENT TERM from the Term menu 

 Check Select ALL Types 
 

 
 

 Print the planner to the screen 
 

 
 
 

17  Year End 
The Year End function is run at the end of the academic year-end in order to move all students up 
a year and move the admissions students onto the current roll.  In training, we will be working with 
a school that has Years K-12 and we will demonstrate two of the three Year End methods for 
allocating proposed years and forms for the following academic year.   
 
The following list outlines the steps involved in the Year End process. Much of the process can be 
set up earlier in the year, with the final Year End rollover being run at a time that suits your school, 
which is either at the end of the current year or the beginning of the next year. 
 
Tick each step as it is completed. 
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Year End Checklist 

Step Function Completed 

1. Bring your datafile up to date  

2. Print form lists for all forms and years  

3. Check Intake for Secondary Schools  

4. Check the leavers year in School Details   

5. Back up the datafile  

6. Set up the school calendar for the new year  

7. Defining Semester/Timetabling Periods  

8. Set up form descriptions for the new year  

9. Set up Leavers  

  10. Increment student’s proposed years and proposed forms  

11. Print reports showing proposed years and forms   

12. Print student lists for future reference  

13. Back up Data File  

14. Process Year End  

15. Check Year End was successful  

16. Process Admissions Students  

17. Move External Roll Students to the Former Roll  

18. Changing Student FTE  

19. Update Staff Details  

20. Update Form Descriptions  

21. Repeating Student; check they are flagged  

22. Assign Family Representatives  

23. Print State Archives Report  

24. Set up New Attendance Year  

25. Notification of Transfer  

26. Checking Student’s Destination School  

27. Purge the Audit Trail  

Note: Step 24 is not demonstrated in training. Instructions on how to do this can be 
obtained in the Admin End of Year Fact Sheet. 
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17.1 Bring your Data File up to Date 

Ensure students who have left have been moved to the Former Roll and students coming to the 
school next year have been added to the Admissions Roll. If the Lesson Attendance module is 
being used, make sure attendance data is up to date.  

DO NOT MOVE LEAVERS TO THE FORMER ROLL. THIS IS CARRIED 
OUT AUTOMATICALLY WHEN PROCESSING YEAR END 

 

Activity 

General > Student Details 

 Find  the students who started yesterday by putting in the Entry Dates 
 

 
 

 Check that each one has been assigned to a Year and Form 

 If not, click Edit   and assign Year and Forms 
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17.2 Print Form Check Lists for all Forms/Years 

It is recommended that users create a checklist for each Form/Year Group in order to show current 
and Proposed Forms/Years.  
 
Setting up this report as follows will produce a checklist for use with the Year End process. Use the 
lists to record Proposed Forms against Current Forms.  
 
For each form group: 

 Write the name of the student’s new (Proposed) Form against the Current Form. 

 Mark the names of individual students who will be moving to Forms/Years that are different 
from the proposed Form/Year for the remainder of students in the list. Some students may be 
repeating their current year. 

 On the lists, mark as ‘Leaver’ any students in the Leavers year (that is Year 6 in most primary 
schools and Year 12 in secondary schools), as well as any other students who will be leaving.  
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Activity 

WA Reports > Reports > WA Reports> Standard Student Checklist 

 Click Standard Student Check List   

 Enter Proposed Year /Form Lists as the title 
 

 
 

 Type any directions to staff in the Footer 

Note: If your school does not have Form groups, you could use the Current Roll Report 
with user Font Size (located in Admin Reports> Roll Reports).  Sort by Year and 
Surname.  

 Click on the Sort tab and double click on Form and then Year 

 Check the Total and the Page boxes next to Form 
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 Click on the Select tab and choose Form  

 Click Select All  
 

 
 

 Click on the Includes tab and enter the following information 
 

 
 

 Print  to the screen 

 Close report 
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Save as a Custom Report  

 Click Save as a Custom Report  

 Enter a name for the Custom Report 
 

 
 

 Click OK 

 View the Report underneath the Custom Reports folder 
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17.3  Check Intake Year for Secondary Schools 

 
Secondary Schools will need to check their Intake Year is set to Year 7 in Year Groups  
 

Activity 
 
General > Control > Preferences 
 

 Select the Year Groups Tab 
 

 
 

 Ensure the Start Year Group is set to Year 7 
 

 
 

 Click Cancel as we will not change the Start Year Group for the Training datafile 

Note: Primary schools should also ensure their End Year Group is set to Year 6. 
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17.4 Check Leavers Year in School Details  

This is necessary so that the students in the final year of the school will automatically be 
transferred to the Former roll as part of the Year End process.  The Leavers Year is probably 
already set up; however check that it is accurate.  
 

Activity 

General > School Details 

 Check the Leavers Year is correct 
 

 Click   to make any changes 

 Primary Schools will have their Leavers’ Year set to Year 6 
 

 
 

 Secondary Schools will have their Leavers’ Year set to Year 12 
 

 
 
 
We are working with a District High School, so the Intake Year will be K and the Leavers’ Year 
will be Year 12. 
 

 
 

 Click Cancel and Yes as we will not make any changes 
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17.5 Back up the Data File 

It is necessary to make a copy of the data file as it stands before you set up a new academic year, 
in case you inadvertently delete the current year’s data.  This involves making a copy of the current 
year’s data file and storing it in a folder where it is accessible if needed.   
 
The SIS Backup Wizard should be used to make a backup of your data at this time. 

IMPORTANT:  
You will be asked to repeat this backup prior to processing Year End 

(Step 13) because of any changes you have made to the data file 
between now and then. 

  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 149 of 218 

© 2019 Civica Pty Ltd 

 

17.6 Set up the School Calendar for the New Year 

Activity 

General > School Details 

Set up the new school year for (2020) 

Note:  Always take a back-up your data file prior to setting up a new year. 

 Click Display School Diary  

 Click Set Up School Year  

 Click Display Diary for Specified Year to double check that the following year has not 
already been set up 

 

 
 

 Click Set up year structure  

 Click OK 

 Enter the year in the School Year field and press <Tab>   
 

 
 

 Click Yes when asked if you want to discard last year’s data  
 

 Change  to  
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Set up terms within the new year:  

 Click Add Term  to add details of terms, ( these are entered one at a time), dates may be 
typed in or selected via the Activity Calendar button 

 

 
 

 Click OK  

Note:  These dates were preliminary dates at the time of the Administration Training 
Notes updates.  Please refer to http://www.det.wa.edu.au/education/termdates/to confirm 
dates prior to input. 

 Add the other terms for 2020 
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Note:  Terms are always entered as starting on a Monday.  If the 
school is not open on the Monday, it may be entered as a Closed day 

in the School Diary. 
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Identify days within the school year when the school will be closed 

 In the School Diary window click on Toggle Paintbrush   
 

 Click in the blue Holiday cell 

 Use the blue chevrons   to navigate to March 

 Enter Monday 2nd March as  Public Holiday 
 

 
 

 

Note:  Schools may conduct School Development Days prior to the students’ return.  As 
the School Calendar is set up to commence on Monday 2nd February, we are unable to 
assign Development Days in January. 

 

Hint:  Click on the actual date.  This will highlight all 3 cells.  To correct an error, click in  
the white cell, click on the error and reselect the correct colour code 
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 Use the blue chevrons  to navigate to April 

 Enter Monday 27th  as a public holiday 
 

 
 

 Use the blue chevrons  to navigate to June 

 Enter Monday 1st June  as a public holiday 
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 Navigate to July 

 Change the Paintbrush Code to green School Development 

 Enter Monday 20th July as a School Development day 
 

 
 
 

 Turn the paintbrush off  and Close 
 
 

 
  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 155 of 218 

© 2019 Civica Pty Ltd 

 

17.7 Defining Semester/Timetabling Periods 

General > School Details > Timetabling Periods 

Timetabling Periods are required for Timetabling, and are used for calculating the number of 
student half day absences in Formal Reports.  Term dates must be entered in the School Calendar 
before Timetabling Periods can be created. 
 

Selecting the  icon will create semester dates. 

Selecting the  icon will create term dates. 
 

Selecting   will allow users to create customised Timetabling Periods.   Schools using 
Timetabling will create the Timetabling Periods they require.  Schools not using Timetabling will 
use the semester Timetabling Periods to enable the reporting of half-day absences in Formal 
Reports. 
 

Activity 

General > School Details 

Define Semesters 1 and 2  

 Click on Timetabling periods  

 Ensure 2020 is selected 

 Click on Create Semesters for School diary  to create semester periods 
 

 
 
 

Note: Primary Schools must click on  to create the semester periods for the lesson 
attendance data for reports to parents to be accurately reported. 
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17.8 Set up Form Descriptions for the New Year 

Important: Do Not Allocate Teachers at This Time 

Activity 

General > Parameters > Form Descriptions 

 Double click on Form Description 
 

 

Note:  Do not edit or delete the Not Specified parameter.  If the Not Specified parameter 
isn’t in the list, contact your Customer Service Centre before proceeding. Only show 
active entries is ticked by default. 

 Click Add  

 Enter the Form Description:  Room 7 (skip the first field Form Code) 
 

 
 

 Click OK 

Note:  The DoE recommends Primary Schools do not use Year Groups to identify Form 
Rooms.  Rooms should be identified as Room 1, Lab 2, Kindy 3 etc. 
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17.9  Speed Edit Leaver’s Details 

Use Speed Edit to enter a Leave Date and Destination for your top year group, and for all 
students who will not remain at the school. This is usually Year 6 students in a primary school, 
Year 10 students in a District High School and Year 12 students in a Senior High School, as well 
as any other students known to be leaving at the end of the academic year. 
 
The processing of Leavers is a two-part function.  Part One updates the leaving student’s details, 
for example: What date are they leaving and where are they going?  Part Two allows the EOY 
process to automatically move the leaving students to the former roll. 

Note:  If the Destination is unknown, use the value Not Specified.  If the Destination is 
known but is not in the list, contact CSC to have it added to your parameter list. 

The top year group in this training data file is Year 12.  Their Leave Date for this school will be 
25/10/19 and their Destination will be Not Specified. 

Do not use Speed Edit to set up Proposed Years or Forms. 
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Activity 

Admin > Speed Edit 

 From the Area drop down menu choose Destination 

 Find  the Year 12 students 

 Click Select All 

 Enter the New Value as Not specified 
 

 
 

 Click Apply Changes  

 Click Save and Yes  
 

Speed Edit Leave Date 

 Change the Area to Leave Date 

 Click Select All 

 Select the New Value of 25 Oct 2019 

 Click Apply changes  

 Click Save and Yes  
 

Notes:  To ensure that both Destination and Leave Date are correctly processed, ALWAYS 
speed edit the change to the Destination first, followed by the change to the Leave Date. 
Primary Schools will enter the Destination as the Secondary Schools that the students will 
be attending (if known). Otherwise students are marked as Not Specified. 
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17.10  Increment Students’ Proposed Years and Forms         

Admin > Year End 

Do not use Speed Edit to set up Proposed Years or Forms. 

There are three ways to increment the students who are moving up a year within the school:  

 Automatic Increment of Year Groups  

 Assign by Year/Form  

 Assign Individuals to a Year/Form. 

Automatic Increment of Year Groups 

If students keep the same class names but move up one year, for example, Year 3, Form Room 1 
becomes Year 4, Form Room 1. 
 

 Select Year End in the Admin sidebar. 

 Click on the Automatic Increment of Year Groups  
 

 
 
The following window will be displayed.  
 

 
 

 Click OK to proceed. 

Note: Registration designation refers to Form. 
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Assign by Year/Form 

If student’s Years and Forms are both incremented by one, for example, Year 8 Form 8.1, 
becomes Year 9 Form 9.1, then choose this option.  
 

 Select Year End in the Admin sidebar 

 Click Assign by Year/Form 

 Complete for all the Forms, changing the Year and Form 
 

 

Assign Individuals to a Year/Form  

The third option enables each Form to be allocated a proposed Year and Form, and it also allows 
for individual students within each Form to be assigned to a different Proposed Year/Form. It is 
important to allocate a Proposed Year and Proposed Form for Leavers. 
 

 Select Year End in the Admin sidebar  

 Click on Assign Individuals to a Year/Form  

 Select the Current Year/Form to display the current student’s names in the Modifications 
pane. 

 Highlight students to be allocated a Proposed Year Group and Proposed Form 

 Select the Proposed Year Group and Proposed Form  

 Click Update Line(s)  
 

 
 

 Click Save Modifications  
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 Check that you have allocated a Proposed Year and Form to each student in the Form  

 Repeat for each Form 
 
For students in the Leavers year, allocate a Proposed Year Group of Leaver and Proposed 
Form of Not specified. 
 

 
 
 
 

17.10.1 Year End Assign by Year/Form 

Activity 

Admin > Year End > Assign by Year/Form 

 Set the Current Year as Year 8 and Form as 8.1 

 Set the Proposed Year as Year 9 and  Form as 9.1 
 

 
 

 Click OK 

 Continue to process the rest of the Year 8’s as in the table below 
 

 

Current Year 
 

Current Form Proposed Year Proposed Form 

8 8.2 9 9.2 

8 8.3 9 9.3 

8 8.4 9 9.4 
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17.10.2 Assign Individuals to a Year/Form  

Activity 

Admin > Year End  

Note:  As the proposed Year/Form for all Year 12s is Leaver / Not Specified, the Assign by 
Year/Form function could also be used.   

Some of the Year 4 students are going into Room 5 and some are going into Room 6 

 Click on Assign Individuals to Year/Form 

 Choose the Current Year/Form:  4/Room 4 
 

  
 

 Select the students from Albert, Jackie to North, Matthew  

 Choose the Proposed Year Group: 5 

 Choose the Proposed Form: Room 5 

 Click on Update Lines 

 Click Invert Selection 

 Change the Room to Room 6 

 Click on Update Line(s) 

 Click Save Modifications 
 

 Repeat to set the Proposed Year and Form for Years 5, 6 and  Form 7/07.1, 7/07.2 and 
12.1 using the following information as a guide  
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All of the Year 5 students are going into Year 6 and Room 7 

 
 

The Year 6s from Room 6 will go into forms 07.1 and 07.2  

 Place Rueben Baker down to Mark Mills into 07.1 
 

 
 

 Click Invert Selection and place the rest of the students in 07.2 
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All of the Year 7/07.1 students will go into Form 8.2  

 

 
 
 



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 165 of 218 

© 2019 Civica Pty Ltd 

 

 
All of the Year 7/07.2 students will go into Form 8.3 
 

 
 
 

All of Year 12 Form 12.1 will be set to Leaver as the Year Group and Form Not Specified 

 

 
 

 Close the window 
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17.11 Reports Showing Proposed Year/Form 

Admin > Year End > Reports Showing Proposed Year/Form 

These reports allow users to check the Proposed Years and Forms prior to processing Year End.  
The Year End process will not proceed until all students have a Proposed Year and Form and the 
Leave Date and Destination have been set for school leavers. 
 

 Form Lists of Proposed Year/Form Groups will generate form lists for the new school year. 
These will be complete, apart from the Admissions Roll students.  Do not use proposed Year 
and Proposed Form for students on the Admissions roll.  Students on the Admissions Roll can 
also be included in reports by checking the Include Admissions Roll box. Admissions 
students are identified on such reports with an asterisk.  

 

 It is recommended that you print a list of students without a Proposed Year or Form or without 
a Leave Date and Destination.  This report is useful for checking that all students have been 
allocated a Proposed Year and Form and a Leave Date and Destination where appropriate.  
The report lists students who have no Proposed Year and/or Form.  If any have been missed, 
make the necessary changes before the End of Year is processed. 

Note: Students on the Admissions Roll can be allocated their Year and 
Form once the Acceptance box is checked.  They can then be 

transferred to the Current Roll once they arrive at school. 

Activity 

Admin > Year End > Reports Showing Proposed Year/Form 

 
 

 Print  to the screen each of the five options in turn 
 

Note: If students are identified without a Proposed Year or Form or without a Leave Date or 
Destination, this will need to be rectified before proceeding. 
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17.12 Print Student Lists for Reference (Optional) 

You may wish to print year and form lists for the current year before finally running Year End for 
future reference.  For example, navigate to Admin > Reports > Roll Reports > Current Roll and 
Admin > Reports > Roll Reports>Year List Reports. 

Note: The system does not retain previous years Form/Year data for students once End of 
Year has been processed. 

 

17.13 Process a Backup 

Process a backup of the data file. This step assumes that users have been provided with the SIS 
Backup Wizard for copying the current year’s datafiles.  If you do not have this application please 
contact Customer Service Centre (contact details below) before proceeding with the Year End 
process. 
 

17.14 Process Year End 

This will move students to their new Year and Form groups and move the students who have been 
flagged as Leavers to the Former Roll.  Each school decides whether to process End of Year after 
the end of the academic year or immediately before commencement of the new academic year. 
 
Processing Year End should only occur when you are ready to roll over your student data.  This 
process can only be carried out in Single User Mode, that is, all users except the person 
performing the Year End process must be logged out of Integris. 
 

Activity 

File > Single User Lock 

 
 

 Type your password and click OK 

 

 
 

 Click OK again 

The Single User Lock is now activated.  
 



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 168 of 218 

© 2019 Civica Pty Ltd 

 

Admin > Year End > Process End of Year 

 

 Click OK 
 

 
 

 Select the correct Attendance Year  

 Click OK 

Note: The processing of Year End may take some time (for example, processing may take 
from 10 to 45 minutes depending on factors such as processor capacity, student 
numbers  and also whether the Lesson Attendance module is being used).  
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 Click Yes 
 

 
 
The UPN academic year is also incremented. 
 

 
 

 Click Yes 
 

 
 
Student records are updated. 
 

 
 
Family Representatives are updated. 
 

 
 

 Click OK.  
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 Click OK.  
 

 
 

 Click OK.  
 

 
  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 171 of 218 

© 2019 Civica Pty Ltd 

 

17.15 Check Year End was Successful 

Activity 

General > Student Details 

 Check that Jackie Albert is now in Year 5/ Form Room 5 

 Check that Adam Alkitik   is now in Year 10/ Form 10.1 
 

Note: If Year End has not processed correctly in your school, contact Customer Service 
Centre. 

 

17.16 Process Admissions Students 

Admitting incoming students may be done at any time, but accepting them to the Current Roll 
should be undertaken after processing Year End.  Most schools do not admit Admissions students 
to the Current Roll until the student/s have physically arrived at the school ready to commence 
classes. Until the student arrives at the school, they should remain on the Admissions roll. 
 
If you are using the School-to-School Import function to import data for students from another 
Integris school, place the incoming students on the Admissions Roll prior to the following steps. 

Note: If Admissions records are being edited at the time of transfer to the Current Roll, the 
record/s in use by other users will not be brought on to the Current Roll.  A message will 
appear to notify the user of the number of records not transferred to the Current Roll.  

This is not a single user mode function. However, it is advisable to use single user lock 
when performing the transfer of Admissions students to the Current Roll. 
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Activity 

All students on the Admissions Roll have been accepted for 2020 

Admin > Speed Edit 

 Choose the Area: Acceptance Status (Admissions) 

 Find  students on the Admission roll 

 

 
 

 Click Find 

 Click on the Year column header to sort the students by Year  
 

 
 

 Click Select and Yes 
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 Click Select All 
 

 
 

 Check the New Value box  
 Click Apply Changes  

 

 
 

 Click Save and Yes 
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Allocate Admissions Students to Forms 

Admin > Speed Edit 

 Select the Area: Current Form 

 Highlight from Wendy Ballarat down to Teong Yardley 
 

 
 

 Select New Value:  Room 1 

 Click Apply Changes  

 Repeat to assign the remaining students to Forms as per the screen shots below 
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 Click Save and Yes, 
 

 
 

  Click OK and Close 
 

Move Admissions Students to the Current Roll 

Admin > Utilities > Admissions Transfer  Current Roll  

 

 Select the second option  

 Enter the Entry Date for the beginning of Next Year 

 Click Next 
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 Click Finish and OK 

 When prompted to check for empty batches, click Yes 
 

 Delete any empty batches 

 Close Administration Utilities 

Restore Multi-user 

 Click Single User Mode  

 Choose Restore Multi-user  

 Enter your password and click OK 
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17.17 Moving External Roll Students to the Former Roll 

All students on the External Roll who are not returning to the school in 2016, should be moved to 
the Former Roll using the utility Admin > Utilities > External Roll to Former Roll 
 
Edit existing External Roll Students and add a Leave Date. 
 

Activity 

General > Student Details 

 Select the External Roll 
 

 
 

 Find Justin Badely  

 Click the Edit   

 Click on the Additional tab  
 

 
 

 Add a Leave Date 

 Click OK 
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Run the External Roll to Former Roll Utility 

Admin > Utilities > External Roll to Former Roll 

  
 

 Double Click on the Utility 

 Enter the Leave Date and Click OK 
 

 
 

 Click Yes to the Warning message 
 

 
 

 Click Yes if prompted to remove students from their groups 

 Click OK to the Updates Complete message 
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View the Student on the Former Roll 

General > Student Details 

  
 

  

The Original Roll can be seen on 
the Student Details screen. 
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17.18 Changing Student’s FTE 

Some students will need to have their FTE altered to reflect their correct attendance at school.  
This will affect both Lesson Attendance and the Census.  
 

Activity 

Admin > Speed Edit  

Increasing the FTE 
 

 Select the Area:  FTE and Part-time status  

 Find  the students in Year P 

 Click Select All  

 Enter a New Value of 1.0 
 

 
 

 Click Apply Changes  

 Click Save 
 

 
 

 Click OK and Yes 
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Decreasing the FTE 

 Find  the students in Year Group K 

 Click Select All  

 Enter a New Value of 0.5 
 

 
 

 Click Apply Changes  

 Click Save 
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When a student’s FTE is set to less than 1.0, a Part Time Selector window will be displayed. 

 Select the Custom radio button 
 

 
 

 Deselect all of the Thursday and Friday sessions and the Wednesday PM session 
 

 Check Use Selected for All   
 

 

 
 

 Click OK and Close 
 

Notes: For further information on preparing Lesson Attendance for the New Year, please 
refer to the Lesson Attendance Manual or the Administration Manager End of Year 
Factsheet.  

For Information on setting up Kindergarten students on a 10-Day Attendance Cycle, refer to 
the documentation on the DoE STIMS website (Under Lesson Attendance) at the link below. 

 
http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-
administration/lesson-attendance-module/fact-sheets 
 

17.19 Add New Staff 

If new staff members are starting at the school, their details can be added through General > Staff 
Details.  This can be done at any time, but is included on this checklist as a reminder  

http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-administration/lesson-attendance-module/fact-sheets
http://det.wa.edu.au/intranet/stims/detcms/intranet/student-information-management-system/sis-administration/lesson-attendance-module/fact-sheets
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17.20  Update Form Descriptions 

Once staff members have been added in Staff Details, they can be assigned Forms and Rooms 
 

Activity 

General > Parameters > Form Description 

 Select the Form 9.4  
 

 
 

 Click Edit   

 Click Find Form Teacher   
 

 
 

 Type ABB in the Name/Number field and click Find 
 

 

 Click Find Form Room   

 Type MUS1 in the Room Code and click Find 
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 Highlight MUS1 
 

 
 

 Click Select 

 Click Ok 
 

Form K/P will have a two new teachers  

 Select Form K/P  and click Edit  

 Find  Mark Alan  

 Find Travis Elliot 

 Find room MUS2 
 

 
 

 Click OK 
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17.21 Repeating Students 

Ensure that for any students repeating the current academic year, the Repeating Current Year 
box in the Miscellaneous window in Student Details has been checked. 
 

Activity 

General > Student Details  

 Use Search to load Abrey Stewart’s records  

 Click Edit   
 

 Change his Year back to Year 10 and Form 10.2 
 

 

 Select Miscellaneous tab  
 

 Check Repeating Current Year 
 

 
 

 Click OK and Close 
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17.22 Assign Family Representatives 

Admin > Utilities > Assign Family Representatives 

Family Representative flags a student as being the one who, for example, is given newsletters on 
behalf of a family.  The field differs from the Family Mail Marker in that the field is attached to the 
student, rather than to the student contacts. 
 
One or more members of a sibling group may be flagged as Family Representatives, although it is 
anticipated that the marker will usually be attached to the eldest or youngest sibling enrolled at the 
school. 
 
The Family Representative Field is available in the personal area of the Student window. 
 

 
 
If a student is added to the database and he or she is to be the family representative for a sibling 
group, check Family Representative.  This will not overwrite any sibling already flagged as family 
representative.  
 
To ensure that all family groups have a family representative, go to Admin > Utilities > Assign 
Family Representatives and choose the options that suit your needs. 
 

 
 
Press OK to run the function. 

Note: This function needs to be run in Single User mode. 
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Activity 

File > Single User Lock 

 
 

 Enter keys and click OK 
 

 
 

 Click OK again 
 

Admin > Utilities > Assign Family Representatives 

 Select Mark Youngest Siblings as Family Representatives 

 Select Apply to ALL Students 

 Leave Tracking ON 
 

 
 

 Click OK 
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 Click Yes 
 

 
 
 

 
 

 Click OK 

 Close Administration Utilities 
 

 Click the Locked in Single User Mode icon  

 Click Restore Multi-user 

 Enter keys and click OK 
 

 
  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 189 of 218 

© 2019 Civica Pty Ltd 

 

17.23  Print State Archives Report 

As part of the End of Year Process, schools are required to produce the State Archives Report, 
which will ensure schools comply with the State Records Act 2000. 
As SIS is not a Records Management compliant system and in the absence of an electronic 
records and document management system for schools, enrolment records for left students held 
within SIS are required to be produced in a hardcopy format.    
 
The process will include: 
 

 Producing the relevant printout (this will list the various student enrolment details for left 
students only). 

 Saving the hardcopy report in a file created in the 859 category of the School Filing System 
e.g., 859/nn STUDENTS – ENROLMENTS – Enrolment details of students who left [name of 
school] in 2019. 

 Retaining the file as an archival record and holding for one year. 
 
At the end of one year, close the file and process it in accordance with the procedures in the 
Records Management Manual for School, College and Campus Records relating to the transfer of 
archival records to the State Records Office of Western Australia. 
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Activity 

Admin > Reports > Ad Hoc Reports 

 Open the Ad Hoc Reports folder 

 Highlight State Archives Report 

 Add the year 2019 to the Main Title 
 

 

Note: The report will only need to show students who have left school in the current 
calendar year. 
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 Click New Query to find the students with the Roll Status of n/s 
 

  
 

 Click on the Date tab 

 Enter Leaving Dates for the current year 
 

 
 

 Print  the report to the screen 

Notes: A copy of this report needs to be saved to the 859 category of the School Filing 
System e.g. 859/nn STUDENTS > ENROLMENTS > Enrolment details of students who left 
[name of school] in 2019. 

Retain this file as an archive record and store for one year. At the end of one year, close 
the file and process it in accordance with the procedures in the Records Management 
Manual for School, College and Campus Records relating to the transfer of archival 
records to the State Records Office of Western Australia. 

 Close Reports 
 

 

17.24   Set up New Attendance Year (if using the Lesson Attendance 
Module) 

This step applies to schools using the Lesson Attendance Module. Please refer to the Lesson 
Attendance Manual to set up your new attendance year.  

(Not Demonstrated in Training) 
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17.25  Notification of Enrolment 

Schools are reminded that they must provide written or electronic notification of the date an 
enrolment commences to the school where the new student was previously enrolled.  This includes 
Primary schools when students are enrolling in Secondary school for the first time. 
 

Activity: 

Admin > Speed Edit 

Confirming Enrolment to the Previous School 

 Select Previous School from the Area drop-down menu 
 

 
 

 Click   to find the students on the Current roll  

 Select the Dates tab and enter an Entry date  range of 1 Jan 2019  to 31 January 2020  
 

 
 

 Click on Find, Select  and Yes 
 
A list of students and their Previous School will be displayed 

Note: At school when this activity is performed as part of the year-end activities, the date 
range would commence from the first day of the new school year. 
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 Click on the Value header and scroll to check the list 
 

 
 

 To print the list, select the printer icon   
 
A Transfer Note or List must be sent to each school identified as the student’s last school, 
advising that the student is now enrolled at your school. 
 
 

 

Note: A Previous School will only display where this has been added in the Movement 
History for the students.  
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17.26 Checking Student’s Destination School 

Schools must also resolve the destination of each leaving student, including those students making 
the transition from Primary to High School, Middle School or Senior Campus.  To assist in this 
process, schools can print a list of all students on the Former Roll displaying their destination 
school. 
 

Activity 

Admin >Speed Edit 

 Select Destination from the Area drop-down menu 
 

 
 

 Click   to find the students on the Former roll  
 

 
 

 Click the Dates tab and enter a Leaving Date range of 04/02/19 to 17/12/19 
 

 
 

 Click on Find, Select and Yes 
 
A list of students and their destination school will be displayed 
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 To print the list, select the printer icon   
 
Where an advice of transfer has not been received for a particular student, the school should 
follow up with the parent to determine the destination and confirm the enrolment with the new 
school.  Where schools are unable to verify student destination following investigation, the child 
may be considered as whereabouts unknown and should be referred to the Student Tracking 
Officer through the District Attendance Coordinator. 
 

Note: Further information outlining this process can be found at http://bswb.det.wa.edu.au 

  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 196 of 218 

© 2019 Civica Pty Ltd 

 

17.27 Purge the Audit Trail 

Activity 

General > Control > Audit  

 Select All Users and Entries in the date range. 

 Enter the last day of the year prior to the previous calendar year 

Note:  Schools are requested to keep the Activity Log for all entries in the previous year 

 
 

 Click Purge  
 

 
 

 Click Yes 
 

 
 

 Click Yes 

 Save to C\Keys\Integris\Outbox with the file name: 2018 Audit Log 
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18 Reports 

18.1 Standard Reports 

Admin > Reports 

Each folder on the left-hand side contains a number of reports. To run a report, click on the 
relevant report to highlight it.  Any Sort Fields and Options will be displayed on the right hand side 
of the window. 
 

 
 
Example: For a Standard Form List report sort options available are listed under Sort Fields. To 
sort the report by a particular field, drag the field name from the Sort Fields box on the left into the 
Sort Field box on the right. Alternatively, double click on a Sort Field to select it.  Place a tick in 
checkboxes to total (count) a field or to display each new value for a sort field on a new page. 
 

  
 
When all the details have been set up, click Print and choose a destination for the file. 
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Some Reports allow the user to select students by Year and Form. Others allow the user to select 
students using the New Query button. This enables you to select students based on a previously 
saved query or to select a new query.  Selecting New Query brings up the standard Student 
Search window. 
 
Once the query has been defined, click Print and choose a destination for the file. 
 

 If you often run a standard report using the same criteria, you can save the settings for future 
use by clicking on the Save as a Custom Report button.  This stores the report settings in the 
Custom Reports folder. 
 

If other users need to run the report, use Allow Custom report to be used by others  so that 
other users can be given access rights to the report. 
 

To expand the whole of the reports tree at once, click on Expand Tree.  
 

18.1.1 General Reports 

Activity 

Admin > Reports > General Reports > Medical Conditions 

 Sort by Form 

 Click New Query to find all the students in the school 

 Tick to Include Daily Management Plan 
 

 
 

 Click Print 
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Admin > Reports > General Reports > Birthday Report 

 Click New Query, find the Year 7 students 

 Sort by Day of month 

 Print to the screen 
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18.1.2 Roll Reports 

Admin > Reports > Roll Reports > Current Roll with User Font Size 

 Sort by Form, then Year 

 Check Total and Page for Form 

 Check Total for Year 

 Use New Query to find all the students in the school 

 Enter Font Size 12 or 14 

 Uncheck Show Reference Number if required 

 Print to the screen 
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Admin > Reports > Roll Reports > Parent/Guardian 1 Phone and Address 

 

 Sort by Form 

 Tick Total and Page for Form 

 Select all students on the Current Roll 

 Click Print 
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Admin > Reports > Roll Reports > Roll Count by Date 

 Type today’s date 

 Click Print 

 Re-Print for Year Levels 

 Check the box for Totals Only 

 Click Print 

 

Note:  This report is best run for the Current Year only. 
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18.1.3 Form Lists 

Admin > Reports > Form Lists > Form List Summary 

 Change the Main Title to Class Numbers 

 Check Include Teacher Name(s) on Report 

 Check Include Family Representative totals 

 Summarise by Year Group 

 Print to the screen 
 

 
 

Admin > Reports > Form Lists > Student Information Card 

 Click New Query, find the Year 6 students 
 

 
 

 Click Print  
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18.1.4 Check Lists 

Admin > Reports > Check Lists > Form Check List 

 Enter the Main Title and Notes 

 Select Year 10 

 Check DOB Column 

 Enter Column Headers (<Tab> to create new rows) 

 Enter Column Width: 2 cm 
 

 
 

 Print to the screen 
 

 Click Save as Custom Report   

 Give your checklist a name and click OK 
 

 
 

 Click Allow Custom Report to be used by others   
 

 

Note: Once a report has been shared, it cannot be unshared. 
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18.1.5 Address Labels 

Admin > Reports > Address Labels > Family Mail 

 Select Standard Labels 8x2 

 Use New Query to find Year Group 10 
 

 
 

 Print to the screen 
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18.1.6 Exports 

Admin > Reports > Exports > Parent/Guardian Email Export 

 Select Export the Email Address for all marked as Family Mail Marker 

 Use New Query to find Year Group 8 
 

 
 

 Click Print 

 Select the desktop to Save the Export file 

 Click Save and OK 

 View and Close the exception Report. 
 
This Report displays any students where no email addresses were located in the student record. 
 

 Navigate to your desktop to open and view the file 

Note: The Export file defaults to save to the Outbox but can be saved in any location. The 
Export file may be opened and viewed in Microsoft Excel. Email Addresses can be copied 
from the excel file and pasted into the “To” box of your email client (e.g. Outlook) 
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18.2 WA Reports 

The WA Reports module has been specified by the WA Department of Education. These reports 
provide schools with additional standard reports. 

WA Reports can be accessed from the Sidebar or from the Student Profile Icon  on the top 
toolbar. If activating from the Student Profile Icon the software will default to open that report. 
 

Activity: WA Reports 

WA Reports > Reports > WA Reports > Student Update Form 

 Use New Query to find Penelope Allen 

 Check the desired Options  

 Enter a Return by Date a week from TODAY 
 

 

Note: Reports for each student may now be started on a new page 

 Print the report to screen 

 View and close the report 
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We can run this report again but this time we can now hide some details from the Update form. 
 

 Click on Hide Details  

 Select some details to hide including Other Student Contacts and click on the cross 
 

 
 

 Click on Other Contacts and select a contact to display and click on the tick 
 

 
 

 Click OK and then Print to run the report again 

 Check that these details have been removed from the report. 
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WA Reports > Reports > WA Reports >Student Profile Report 

 Click on Student Profile Report Icon   
 
This Icon provides a shortcut to the WA Reports Sidebar and defaults to the Student Profile 
Report. The Student Profile Report can give us an overview of Behaviour, Attendance and 
Student Activity data. These can be accessed all at once or separately through this report. 
 

 
 

 Enter the dates as 1 Feb 2019 to today’s date 

 Click on New Query 

 Find Tamara Bandy 
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 Click on the Behaviour Types/Actions tab 

 All Behaviours are checked by default  
 

 
 

 Click on the Attendance tab 
 
Show attendance details is checked by default 
 

 
 

 Click on the Activity Types tab 

 Check Show Activity Details 
 

 Click Print 

 View and close the report 
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WA Reports > Reports > WA Reports > Family Representative List 

 Click the Sort tab 

 Sort by Form then Year 

 Check Total for Form and Page 
 

 
 

 Click the Select tab 

 Click the radio button for Form 

 Click Select All   
 

 
 

 Click the Includes tab 

 Check Selection Criteria  
 

 
 

 Print to screen 
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WA Reports > Reports > WA Reports >Student Health Care Summary 

 
The Student Health Care Summary (Form 1) is now available through the WA Reports menu  
 

 Click on New Query 

 Select all the students in Year Group K 

 Type in a footer message 
 

 
 

Note: As this form is being run as a report, it does not create a Student Activity log 
against the student’s record. 
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WA Reports > Reports > WA Reports > Students with a Documented Plan 

 

 Select All Students in Care of DCP 

 Click Print 
 

 
 
 
This Report can be run to show ALL students with a Documented Plan or select them based on 
the Plan Completion and/or Review Dates. 
 

 
  



  

 
Integris Administration Manager Training Notes 21-Jan-19 

Page 214 of 218 

© 2019 Civica Pty Ltd 

 

 

18.3 Report Security 

There are three main steps in setting up access and security for Admin Reports: 
1. Allocate report security access rights to appropriate users 
2. Set the report security profile  
3. Activate Report Security 

Step 1: Allocate report security access rights to appropriate users 

This enables the appropriate users to specify which reports are accessible by which Integris users.  
Access can be enabled in General > Control > Users - in the Reports section of the Access Control 
window. 
 

 
 

Step 2: Set Report Security Profile 

This function enables schools to allocate access to specified reports to users as appropriate.  The 
function is only available to users who have had access rights allocated in Step 1. 
 
There are two options for allocating access to reports: 

1. Allocate Reports to Users   

2. Allocate Users to Reports   
 

Note: It is recommended that Schools contact the Customer Service Centre to discuss their 
needs and are encouraged to carefully consider all possible implications before using 
Report Security Settings.   
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19 Backing Up 
 
For Department of Education and Training schools, a back-up is completed each day on your 
server.  A warning message will be displayed if a back-up is unsuccessful.   Should this warning 
appear, please contact the Customer Service Centre. 
 
The Backup Wizard is available for backups required before performing major changes to the 
datafile.   
 
If you do not have the SIS Backup Wizard please contact the Customer Service Centre on 9264 
5555 or 1800 012 828 
 
In the case of a system crash, your data may be restored from the backup so it is imperative that 
your back-up routines are stable and regular. 
 
 

20 User Accounts 
RM Asia-Pacific will have set up three users on the system: 
 

 EDWA – for the Department to assist you remotely 

 ADMIN – for Civica to assist you remotely 

 SCHADM – this is the System Administrator account for the school 
 
For security purposes, you will need to change the password for the SCHADM user. 

Set up the required users’ user names, passwords and access. 
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22 Support 
Should you require support please contact the Customer Service Centre (CSC) at the 
Department of Education and Training. 
 
Contact details below: 

22.1 Phone (CSC) 

Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 

22.2 Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 

22.3 Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 

23 Online Manuals and Training Notes 

23.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
www.civicaeducation.com.au 
 
Select Support | Integris Support  
Click Login for Western Australian SIS Schools  
Username: school 
Password: help 
 

23.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
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